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A few days ago, I signed up for an account on
the http://amplalian.com Web site. I then made 
a purchase, and at the end of credit-card process-
ing, I got nothing back. That is, no completion
page—only a blank page like the form I had 
just submitted.

As I had received the usual “welcome to our site”
e-mail, I responded to it with my concern about my
order. Here is what I said:

I am somewhat concerned. I placed an order.
Clicked on confirm (for credit-card processing), and
after about a minute, I just got back a blank version
of the page I had previously been on. So, not sure it
got ordered. Note that I am using the Konqueror
Web browser, and some sites don’t handle the
pages properly.

I received two responses. One was from the sales
people about sorting out my order. The second one,
however, surprised me. Here it is:

Phil,

I apologize for the problem you had with your
order. We have recently installed a new credit-card
processing system, and unfortunately we didn’t
have the opportunity to test it with Konqueror.

The minute delay you experienced is the time taken
for our server to contact the HSBC secure payment
server and to receive the response from them.
However, it concerns me that you were taken back
to the payment details page after this point.

In order to solve this problem, I wonder if you could
answer a couple of questions for me please:

Do you know if your browser is set up to accept
session cookies?

Did you do anything on the site after being taken
back to the payment details page?

FROM THE PUBLISHER

PPrroommoottiinngg  FFrreeee  MMaarrkkeettss
Competition relies on choice and others in the market 
recognizing that they should not take our choices for granted.

PHIL HUGHES
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How did you come to the site originally?

Were you behind a proxy server or
firewall when you accessed the site?

Also, I’d be very grateful to know the ver-
sion of your OS and of Konqueror you are
using so that we can test this process fully.

Thank you for your help, Chris

I belive this is the first time I have
received a reply to a Web-related prob-
lem that didn’t include an explanation
of how the site would likely work better
with IE or that possibly it would also
work with Netscape.

Beyond that, Chris didn’t ask me
what Konqueror was, and he didn’t use
the M word once. It was as if he has
taken seriously the idea that the Web is
really platform-independent.

Why do I believe this is so impor-
tant? I feel it has implications way
beyond the Web. Take the Oasis Open
Document Format as another example.
The MS-Word format for documents
became a de facto standard at the
expense of its competitors. There 
wasn’t anyone saying that Microsoft
shouldn’t be able to sell a word 

processor. The issue was that Microsoft
should not get special treatment in the
market. With the adoption of the Oasis
format, Microsoft will be forced to
“play fair”. That is, as people move to
this portable format, they will pick
Microsoft Word only if it is the best
choice technically and financially.

At the very least, we are just pro-
moting a free market. Linux itself is, of
course, a big player there. In all these
cases, we are just supporting the idea
that the consumer should not get
locked in—that the consumer should
continue to have a choice.

We see this in the GNOME vs. KDE
wars. At a minimum, having choice out
there encourages each to try to be bet-
ter than the competition. Some parts
of better are clear. More reliable, more
secure and runs faster are just plain
good. But, there is more. If we do what
we can to make sure there are choices
that interoperate, market share will no
longer be just a function of marketing.

Customer demand actually gets back
into the equation.

If you want to help promote this
openness, there are some things 
you can do. First, if you are using
Konqueror, make sure it identifies 
itself as Konqueror. In the Browser
Identification configuration menu, 
you can set this. Generally this is the
default. The point is, don’t pretend you
are IE—show your Linux stripes.

When sharing documents, suggest
an open format such as the Oasis one.
Or, better yet, suggest to others that
they at least try an office suite such as
OpenOffice.org. It’s just, well, open.

And remember, none of this means
you saying Linux is the only answer. It is
just you saying there should be choices.
Even with choices, not everyone will
pick Linux, but a lot of us will. And, the
more we have on our team, the easier
it is to make our team grow.�

Phil Hughes is Group Publisher for SSC Publishing, Ltd.
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IN ALL THESE CASES, WE ARE JUST SUPPORTING THE IDEA
THAT THE CONSUMER SHOULD NOT GET LOCKED IN—THAT
THE CONSUMER SHOULD CONTINUE TO HAVE A CHOICE.
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I no longer work for Evans Data
Corporation. It was a terrific experience,
and I will miss many things about my
work for Evans. But it’s hard enough bal-
ancing my job as a full-time single father
of two young children with more than
full-time work, so I had to give up some-
thing. Evans was that something.

I finished about half of the most
recent Evans Linux developer survey
report, however. It contained many inter-
esting trends that are relevant to desktop
users despite the fact that the survey is
aimed at Linux developers. First, you
should know that the respondents in this
particular survey seemed to include more
Windows fans and Windows users than
previous surveys. This skewed the results
just a bit, but not enough to mask some
very significant trends.

The trend that stood out the most for
me was the fact that Linux developers are
switching from commercial Linux to non-
commercial Linux in a big way. Examples
of commercial Linux are Red Hat
Enterprise, SUSE and Mandriva. Linspire is
commercial, too, but it isn’t targeted at

developers, so the survey didn’t really have
any useful information about Linspire.

This trend isn’t something I extrapo-
lated from the data. Evans specifically
asked developers if they prefer commer-
cial or noncommercial Linux. During the
past year or so, developers shifted from
favoring commercial Linux over noncom-
mercial Linux to favoring noncommercial
Linux by a near landslide.

When Evans asked what Linux people
were using, the data showed significant
growth for Debian and Fedora. Both are
noncommercial and free. But the biggest
winner in the category of favorite distri-
bution was always “Other”. Maybe Evans
will find out what distributions fell in the
Other category in the next survey, but I
think I can guess. I’ll bet the Other cate-
gory represented distributions like
Knoppix/Gnoppix (Knoppix uses KDE by
default, Gnoppix uses GNOME) and
Kubuntu/Ubuntu (Kubuntu uses KDE 
by default, Ubuntu uses GNOME). Evans
didn’t identify these distributions by name,
so Other is where they would have to
show up. I don’t think Other was limited

to these few distributions, however. There
are plenty more noncommercial distribu-
tions enjoying popularity right now.

Here’s another thing to think about.
Each Evans survey asks how much Linux
developers are willing to pay for compil-
ers, editors, databases and so on. A sur-
prising number of people are still willing
to pay $500 US or more for these tools,
but the vast majority of developers say
they intend to pay little or nothing at all.
Who can blame them? They have tools
like KDevelop, Quanta, Eclipse and more.
These tools are top-notch, ridiculously
feature-rich and free as in free beer.

EI-EI-OFFICE
All of this information haunted me while
I was editing Ricky Freedlander’s review
of EIOffice for last month’s issue of
TUX. I kept thinking, “So it’s better than
OpenOffice.org. So what? Given the trend
among Linux developers, will any Linux
users actually pay for a software product
when they can get something equivalent
to it that is good enough and free?”

For the record, I can think of only a few

FROM THE EDITOR IN CHIEF

WWhhaatt  WWiillll  YYoouu  PPaayy  FFoorr??
The trend toward favoring all things free, as in free beer, raises the question as to whether Linux users will pay for anything at all.

NICHOLAS PETRELEY
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Linux software products on the market
that I would pay for. I would pay for
Linspire (http://www.linspire.com), Win4Lin
(http://www.netraverse.com), CrossOver
Office (http://www.codeweavers.com) and
EIOffice (http://www.evermoresw.com/
weben/index.jsp). I admit, I added EIOffice
based only on Ricky’s review. I personally
reviewed an earlier version of EIOffice, and
although the early version was quite good, it
had problems that would have prevented
me from buying it. The problems seem to
have been solved in this latest version, so it
finally made it to my list of products I’d buy.

In case you’re not familiar with the
above products, Linspire is by far the
slickest desktop Linux on the planet.
Win4Lin lets you install and run Windows
from within Linux. It’s an easier way to
run Windows applications than, say,
VMware (although VMware is well worth
the money if you need certain features
you can’t get with Win4Lin). CrossOver
Office lets you run Windows programs on
Linux without having to install Windows.
Why would I want both? The full answer
is material for another column, but trust
me, I like having both. EIOffice is a Java-
based office suite that looks and works
almost exactly like Microsoft Office with
an amazing twist. We reviewed it in the
last issue of TUX, so download that issue
for more details.

Let me add one more bit of informa-
tion. I am about to purchase a subscrip-
tion to Transgaming (the Transgaming
product called Cedega allows you to play
Windows games on Linux). At this point, I
don’t know if it will be money well spent,
but I might have to add it to the list of
products I would buy.

Don’t read too much into the obvious
pattern that three of the products I’ve
mentioned have to do with running
Windows programs on Linux. Evans Data
and some book publishers insist on work-
ing with Microsoft Word. This means I
have to use Microsoft Word to get some
of my work done, hence the need for
software that allows me to run Windows
programs on Linux. If you don’t need to
use Windows programs for business rea-
sons, you won’t need products like these.
Fortunately, SSC, the company behind
TUX and Linux Journal, doesn’t rely on
legacy software like Microsoft Word.

As for Cedega, what can I say? My
kids play games (and so do I in my spare
seconds per week). Some of the best
nonconsole games are still available only
for Windows, and I want my kids to run
Linux by default. If they’re going to run
Linux, they need a product that lets them
play their favorite games on Linux. More
people play games than write books, so
this is a more-significant area where Linux

is still haunted by the “everyone runs
Windows” legacy.

THE $64 QUESTION
Okay, the current state of games aside,
my $64 question is this: what would you
put on your list of software products that
you are willing to buy? Did you buy your
copy of SUSE or Mandrake, or are you
using the free limited editions? Would
you buy Linspire or EIOffice? Would you
buy a commercial graphics program like
Photogenics, or perhaps a commercial
DVD player for Linux so you can avoid the
controversy over the legality of free DVD
players? Of course, if you buy Linspire,
you won’t have to worry about legal
issues, which is an advantage we didn’t
know about until this issue (see Letters).
A few terrific games are available that run
natively on Linux. If more games ran
natively on Linux, how many of you
would buy them?

How many of you would actually pay
for superior Linux software even if an
equivalent “good enough” program was
available free? This is not a rhetorical
question. I’d really like to know. I’ll be
checking my inbox.�

TUX Editor in Chief Nicholas Petreley is an author,
consultant, programmer, award-winning columnist
and previously was Linux analyst for Evans Data Corp.
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The Desktop War That Wouldn’t Die
Mango should love this one—Novell will be standardizing on
GNOME for their Linux Desktop’s default desktop, and this is
where they will be focusing their development efforts. This
seems to me to be a monumentally foolish move. As someone
who has been pushing for more adoption of Linux on the desk-
top in government, I find this move very frustrating. GNOME, in
its current state, is not appropriate for new Linux users.

I have found through personal experience, overwhelmingly, that if
you put current Windows users in front of a Linux desktop with
KDE, they become accustomed to it fairly quickly. However, if you do
the same thing with a GNOME desktop, expect an order of magni-
tude more calls to the help desk with questions like, “Okay, how do
I do this....” GNOME is getting better, but for those that like it (not
me, I prefer KDE for myself), it is still really ready only for admins and
those already well accustomed to Linux. Even Ubuntu, one of my
other favorite distros, is going to be focusing more efforts on KDE
(http://www.kubuntu.org/announcements/kde-commitment.php).
Mark Shuttleworth, Ubuntu founder, even is using Kubuntu with
KDE as his desktop now.

Who at Red Hat and Novell is making these decisions to stan-
dardize on GNOME, and have they actually talked with cus-
tomers or those trying to get new users migrated to Linux? Red
Hat and Novell, the two top corporate distros, are not helping us.
--
Eric

Hubert Mantel, cofounder of SUSE, recently left Novell, saying,
“I’m very confident the Novell management will find a competent
successor very quickly. After all, there are lots of extremely skilled

people over there in the Ximian division.” This sounds (to me) like
a pot-shot at Ximian, which is GNOME-centric. Chris Schlaeger, a
longtime KDE contributor and former vice president of research
and development at SUSE Linux, just resigned too. What’s going
on? Sounds to me like there was a political war between SUSE
and Ximian over GNOME vs. KDE, and Ximian won.—Ed.

Desktop Poll Results
This is a poll from the tuxmachine Web site. KDE [was favored
over] GNOME 51% to 21%—that’s 3 to 1. So GNOME dogs have
no [foundation] for their complaints. And Kubuntu is growing fast,
and it will be an official distribution of the Ubuntu community

From (http://distrowatch.com/weekly.php?issue=20051107#2):

The fans of Kubuntu had a reason to celebrate last week as their
preferred distribution is gradually getting the recognition it deserves
from the Ubuntu founder. In his opening remarks at the start of the
conference, Ubuntu founder Mark Shuttleworth announced that he
was now using Kubuntu on his desktop machine and said he want-
ed Kubuntu to move to a first-class distribution within the Ubuntu
community. The large number of Kubuntu users at the conference
was evidence as the need for this.

Free CDs for Kubuntu through shipit should be available for the
next release if the planned Live CD Installer removes the need for
a separate install CD.

On a related note, a rough feature list of the upcoming Kubuntu
Dapper Drake is now also available for your reading pleasure
(https://wiki.ubuntu.com/KubuntuDapperRoadmap).

LETTERS
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And your magazine is great...keep doing it.
--
E. Vargas

Happy User Anyway
I have been an avid reader since your first edition. It was
enough encouragement for me to have another go at Linux.
Regarding the letters about KDE being the preferred desktop—
I have been using Ubuntu and Fedora distributions that use
GNOME as the default. Then along comes the latest SUSE, and
in a local mag review, a glowing KDE. I could not resist spend-
ing a little of my pension dollars. Have you guessed the out-
come? Only the GNOME desktop loads. I am still smiling,
despite still not being able to set up a printer.
--
73-year-old learner, Sale Victoria

Want Command-line Tips and Giving Praise
I am grateful for the existence of this magazine. I’ll be happy if
every now and then you could give a few tips on how to use
the command line (explaining one or two special commands at
a time). Linux is not only GUI after all.

I am a strong supporter of Mango Parfait (even though she
doesn’t like Mandrake/driva, my preferred distro), and I really
enjoy her wit and sarcasm.

There is a lot to learn from her page. I also appreciated your/her
comments on GNOME a lot, a desktop that I really find difficult
to work with. I could say more in appreciation of your work
(and in a better way, but English is not my mother tongue). So,
thanks and keep up with your good work.
--
Santo

GNOME Not So Bad
Thanks for the great mag—I’m hooked! I’ve been a Linux user
for only a few years, but I’m having plenty of fun. As for the
KDE/GNOME issue, well, I use both. I’m finding KDE is much
more accessible, and after using GNOME, I find it really does
have a quirky logic, but once you get to used to it, well, it
becomes familiar in a logical sense. For example, the usual com-
plaint about Nautilus leaving a trail of open windows easily can
be solved by right-clicking on the desired directory and selecting
browse. Thanks again for the great work guys, I really enjoy the
layout/format in particular.
--
Dan Penny

What’s in the Open Box?
I switched to Linux (Ubuntu distro) at the ripe young age of 17
(my current age apparently) and just so happened to come
across TUX magazine through a friend of mine, who ironically
hasn’t changed to Linux yet. I really like the magazine so far;
however, I couldn’t help but notice the ongoing debate about
which is better to use, KDE with its artsy Apple chic, or GNOME
with its uhhh, GNOMEy feeling (no offense GNOME users/fans).

But what about using Openbox? Although it is believed that
Openbox is simply a WDM (window manager) for GNOME or KDE,
it is possible to run it alone. As a GUI, it is very light and runs faster
than Fluxbox! It is not a RAM-suck like KDE and does not require
as many resources as GNOME. In fact, when I ran no apps and I
viewed my RAM usage with Conky (an Ubuntu system monitor)
I used less than 42MB. However, the only drawback is that there
is no panel(s), and some experience may be required for 
customization (for example, the background may require the use
of bbrb, and if you want a panel, you need fpbpanel and so on).

P2P
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If you are interested in using Openbox, visit
http://icculus.org/openbox.

Or, if you are running Ubuntu like me, type sudo apt-get
install openbox obconf and view this thread:
http://ubuntuforums.org/showthread.php?t=75471.
--
Bryan Baraoidan

We have an article on how to set up and use Fluxbox already
scheduled (Fluxbox is one of my personal favorite desktops,
by the way). We’ll look into covering Openbox too (another
favorite of mine).—Ed.

There’s a Gem, Ndiswrapper
Your article on Ndiswrapper [see the November 2005 issue of TUX]
is a very good read for people trying to get their wireless cards up
and running under Linux. I notice that you are using SUSE 9.3 and
you say that it is the same to set up a wireless network in most dis-
tros. I am a Slackware user who tried using the wireless tools that
come with Slackware 10.2, and I cannot get the wireless card up
and running. The only way that I know how to it is to do every-
thing though the console when setting it up, but of course, I am
one of those people who like to use the console more than the
KDE GUI for setting up settings and other tweaks.
--
Matt Donovan

Xpdf Does Too
So I finally found the link to write you about your nice TUX
magazine, hidden deeply in this drupal installation of yours.

I’m afraid I have a small correction to make. In your November
2005 article about Evince you claim that xpdf isn’t able to select
text from a PDF file, but this is wrong. Simply select it with the rec-

tangular select tool and paste via the middle mouse button. You
are right on the other critical points though. I always wondered
why xpdf is so keen on re-rendering complex PDF again and again,
taking hours to get in sync with a window resize. Notable, though
perhaps less apt to a new user magazine, are the command-line
tools xpdf provides to extract text and images from PDF files.

Let me close with my best wishes for your magazine—it’s a nice
read for the seasoned Linux user too. I especially liked Mango
Parfait’s “I anal too” legal disclaimer. Perhaps you have to be
into anime to appreciate the humour.
--
Thomas

Married to Xandros
I just subscribed to TUX. Why? I heard that it was slanted. I wanted
to judge for myself. Let me start by saying that I am a Linux user
with ten years of experience. I believe Linux is the best operating
system. The distros I’ve installed are multiple versions of Slackware,
Caldera, Red Hat, SUSE, Debian, TurboLinux, Stampede Linux, Corel
and others I can’t recall. My point? I’m not a newbie.

I read the November 2005 issue and don’t understand your dissatis-
faction with the Xandros distro. From where I stand, it is a step for-
ward for Linux users who need to work in a Windows network
with some Windows tools. It does it right and it does it slick—great
for the new and seasoned user alike. I switched from SUSE because
Xandros installs out of the box as a svelte install without extraneous
software. Everything I need is up and running for desktop use with-
out effort, and if I do need a server, I’ll get the server package. The
support has been great. The forum system is excellent.

Lastly, comparing is good; showing disdain for another distro is
bad. It reminds me of these popular hate radio/TV programs
that pit Republicans against Democrats. Yeah, us against them—

P2P
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just what your competition wants to see, Divide and Conquer.
Each distro has its strengths; none are bad.

You’re reading this Bill. You’re smiling Bill, this you already knew.
--
R Talbot

Linux will die if anyone dares criticize a Linux distribution? No
Linux distribution is bad; they’re all great? Come visit the real
world sometime. I don’t like the current version of Xandros.
Others like it. Time permitting, I’ll review Xandros and then
you’ll see exactly what I don’t like. Until then, deal with the fact
that people have different opinions.—Ed.

A Brief Affair with Xandros
In May of this year, Windows and I agreed to a trial separation. I
installed Xandros and quickly realized that Windows is much bet-
ter at marketing than it is at building software. Actually their OS
(Windows XP) is pretty good, except for security.

Anyway, after I had used Xandros for a while, I realized that it had
some shortcomings I just could not live with. I started reading
reviews of Ubuntu/Kubuntu, installed it and expect to live happily
ever after. I am now ready to turn my separation from Windows
into a divorce, except for one problem that I cannot find an
answer to. For years I have been doing my annual taxes on Turbo
Tax. How does the Linux community do its taxes? If I can find a
way to do taxes on Linux, I will be able to sign the divorce papers.

Thank you for providing a wonderful magazine. I read it cover to
cover every month.
--
Bill Rowland

A Xandros Divorcee
You describe TUX as targeted at new users, but as someone
who’s been using Debian for two and a half years (a Mac OS X
escapee), I find your magazine entertaining and informative—
one can’t ask for much more than that; so thanks.

We work in the business of migrating clients to Linux (Debian
and related distros), and keeping in touch with what newly con-
verted users use and like is essential. I share your antipathy to
Xandros on two counts: I prefer to avoid using MS Windows
applications if possible, although I understand it is very polished
in that area; when I tried it, LILO was its boot loader, which is
incompatible with running GRUB-based multiboot installations.

After many months of testing a number of distributions, we
have a few we recommend: Debian for those who are of an
inquisitive bent. Kubuntu and Ubuntu (we prefer KDE; although
with use, GNOME grows on you).
--
Clive

The problems I had with Xandros’ custom version of LILO is one
of my many complaints about the distribution too.—Ed.

A Love Affair with Linspire and Breakup with
OpenOffice.org
After trying a number of distros, I decided to follow your advice
and bought Linspire. I am very happy with the decision. It is
especially pleasing to be able to download applications with
Click & Run and find that they work well. I now have all the
applications I need. I found the slow loading of OpenOffice.org
annoying and thus downloaded Abiword and KOffice.
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I hope Linux programmers can work on the problem of the slow
loading of the OS and OpenOffice.org. In a modern system,
speed is essential.
--
Alan Duval

Click & Run is wonderful, isn’t it? Unfortunately, you have to
experience it yourself to really appreciate it. OpenOffice.org loads
slowly on every distribution, unless you’re using the quickstarter
program that comes with OpenOffice.org. You have to sacrifice
some resources to have the quickstarter running all the time, but
it often solves the problem for OpenOffice.org fans.—Ed.

About TUX
I’ve discovered TUX magazine today, and I want to send you my
congratulations. I’m pleased to read your magazine ’cause it’s
easy, nice and free! Thank you for doing that!
--
Ziz0u

Mango Is Appreciated
This mail comes to you from India.

I really appreciate the efforts involved in bringing out a wonder-
ful magazine meant for newbies, and being able to download it
for free, even though it’s in a locked-in format (PDF files).

Mango reminds me of my girlfriend. She speaks her opinion,
and those who object to her are most welcome not to read her
column. As for me, I look forward to the issues because she
explains everything so succinctly and in a clear and lucid style.
As a newbie (even after one year of Linux), I believe that I could
welcome any kind of help to make me able to control the distro

the way I want and not use the defaults. Mango’s columns help
me achieve that.
--
Dr Abhishek Puri

Don’t Forget SCSI
Great mag! Great articles for a newb like me. (New to the
world of birds in tuxedos—my first computer was a Sinclair
that I assumed I was going to assemble myself, but they ran
out of kits and sent me a fully assembled unit.) In Nick’s (may
I call you that?) article on booting multiple distros (TUX,
November 2005), I didn’t think I’d get all the way to page 31
on the first day! An explanation of GRUB drive numbering
was given and was easily understandable for as far as it went.
What could really help me—and others in a similar situation—
would be a few pages on how drives are “counted” in Linux,
GRUB and any other OS-level drive schemes that include SCSI
and IDE (including Serial).
--
Leyden

I apologize for leaving SCSI users out of the loop in that arti-
cle. It was a very long article as it was, and I wanted to keep
it simple. Perhaps we can do a follow up on GRUB and SCSI
sometime.—Ed.

Love TUX
Thank you! You are publishing a magazine modeled for the
future. TUX magazine in its e-mailed, PDF format shows up in
my inbox and opens into a glorious glossy-like spread that nearly
takes my breath away. I caught myself sniffing the screen for
that “new paper” smell that I get from my other very high-qual-
ity publications (LJ, Dr Dobbs and so on). Your magazine should

P2P

11www.tuxmagazine.com

http://www.tuxmagazine.com


serve as a model for many others to come. Come to think of it, I
would actually be willing to pay for it, especially if it gets a little
thicker and more technical, similar to LJ. This is a mag that I
could actually get my parents to read.

I have many other good things to say about it, but for now,
keep up the good work! Looking forward to the next issue
already and wishing I had the back issues. (Is there a way to get
them—you’re only on issue #7?)
--
Jonathan Harmon

You can download whichever issue you like if you’re a sub-
scriber. Simply go to http://www.tuxmagazine.com and click on
Download TUX on the top right of the page. There you can
select the issue you want.—Ed.

More Love for TUX
I just wanted to let you know how much I love and appreciate your
magazine. I love the format, content and colorful layout. It’s a pleas-
ure to read. Although I have been a Linux enthusiast for years, there
are still many things that I learn (and re-learn) from your magazine.
For example, the article on The GIMP [see the first five issues of TUX
for articles on The GIMP] was a great help to me. It jump-started
me into something that I wanted to learn for a long time. Thanks
for doing such a great job. Please don’t change a thing.
--
Rick Lucent

More Support for Mango
Congratulations for your grrrrrrrrrrrreat magazine.

I’m a new reader from Chile, and I’m a total newbie on
Linux, and your articles have been very helpful. I really loved
The GIMP and Inkscape articles, and I have a lot of fun with

the Mango Q&A section. I don’t think she’s rambling or
something—personally I think she’s the coolest girl in TUX
magazine, and I find her opinions both unbiased and funny.
I don’t think she deserves all the “bad press” she’s getting.
So one letter supporting Mango is the least I can do for her.

I also enjoyed the lightweight window manager article [see the
September and November 2005 issues of TUX for the light-
weight window manager articles by John Knight], cause I have
a veeeeeeery old machine (K6-2 450MHz, 192 RAM) running
with Kubuntu on it. The performance is acceptable, but I’d like
to hear if you have any suggestions on this subject. Anyway,
I’m getting a new PC, and I think Linspire will be my choice,
not only for the great press Linspire is getting, but because I
tried the live CD version of Linspire, and I was very, very
impressed—’nuff said.
--
Jorge

I’m sure Mango is blushing but will never admit it.—Ed.

Evermore Appreciation
Thank you for that amazing review of the Linux version of
Evermore Integrated Office [November 2005].

If I am ever able to get approval from Gus Tsao, stay tuned for
news over the next several months....
--
Steve Leon

What Linux Needs
Recently I’ve really gotten into working with Linux. I’m currently
using CentOS 4.0. I really like this distro out of all the others I’ve
tried in the past. The only major drawback I have to using Linux
full-time is the fact that it is so damn hard to get my Windows
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games to run. Yes, I understand that WINE and another tool are
available for making this happen, but the problem is (at least
with WINE) that it is so difficult to get a game running. If Linux
really wants to have a greater market share, they need to stop
thinking like geeks and make things work so that any dummy
can use it. Microsoft, no matter how much the Linux community
hates it, has done just that. Users don’t need to make a ton of
command-line switches and point to a third-party utility to make
their games work. They stick a CD in, let it autorun, install, then
play the game.

I personally would love an alternative to MS Windows. I would
love for a change to buy the “18-port switch” and jack in all my
computers without a EULA stating I have a license to use only 5
of those 18 working ports.
--
Michael Heath

For the benefit of other readers, CentOS is based on the
open-source code for Red Hat Enterprise Linux. Cedega
(http://www.transgaming.com) makes it possible, not necessarily
easy, to run many Windows games on Linux. Personally, I’d
rather see native Linux games than a better solution to running
Windows games, but that’s a market demand issue.—Ed.

Do the Moneydance
I read the Letter to the Editor about a Quicken replacement for Linux
in the November 2005 issue and offer the following suggestion.

I’ve been using Linux for several years and even though I
replaced most all my other Windows application software
with Linux equivalents, I was still stuck with Windows and

Quicken because of their on-line bill payment option. I tried
a version of GNUcash, and it just did not have the on-line
option available at that time. Then I found Moneydance
(http://www.moneydance.com). No more dual-booting to do
my banking under Windows and Quicken. Moneydance has
given me the freedom to do on-line banking and manage
my finances directly in Linux.
--
Kevin F. Crosby

Good-Bye Humor, Abyssinia
[In reference to Mango Parfait referring to Lithuania as a name
in the November 2005 issue.]

Now, let me explain something to you...LITHUANIA is a country
not a name, so this guy’s (or girl’s) name is Gytis, and he/she is
from Lithuania (Europe).

PS: Ireland is NOT my name! eheheheheh....
--
Paulo Jacob, Ireland

Dear Mr. Ireland Paulo Jacob, Mango was joking. Didn’t 
you notice that she recommended that he use the alias
“Abyssinia”?—Ed.

Civil Disobedience
[Re: “Civil Disobedience and Linux” by Nicholas Petreley in the
November 2005 issue.]

You are mistaken in your metaphor comparing a book and
chapters of a book to Windows and Windows drivers, in order
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to clarify your ethical opposition to the copying of Windows
drivers by people who do not own Windows.

Windows is not the book, but the book reader, and Microsoft is
working very very hard to make all books readable only with their
reader. Microsoft’s past business strategy has been to make peo-
ple as dependent as possible upon their technology by way of
exclusive tied selling of their products with other companies. This
is an illegal practice for which they were convicted in both Europe
and America. As their punishment was a mild slap on the hand,
they have not been dissuaded from continuing this practice.

Until such time as Microsoft loses their virtual monopoly on
personal computer technology or there is a serious effort by
authorities to regulate them properly, any small infractions
of copyright in order to promote compatibility should be
considered “fair use”.

This is a perfectly reasonable ethical point of view, even as you
say, it is not legal.
--
Darryl Moore

More on Civil Disobedience
In your November 2005 article, “Civil Disobedience and Linux”,
you mention that:

In this issue, Mango Parfait explains to a reader how to play
wma (Windows Media audio files) on Linux. The process involves
downloading a set of Microsoft codec files and installing them
on your Linux distribution. I don’t know of any Linux distribu-
tions that include these proprietary files with their software.

Linspire OS includes WMA though 9 support and has received
full permission to do so by the Microsoft Corporation. We are
also licensed to use the Quicktime Windows codec. We, however,
do not have permission for Windows Lossless and Windows
Speech codecs or DRM.
--
John Sanborn, Director of IT, Linspire Inc.

I sit corrected. Thanks to bringing this to my, er, our 
attention.—Ed.

Database Development Environments?
I have been looking for a database system development
product in the Linux world that is similar to FileMaker Pro 
or to Access. Thanks to your magazine I did find the LAMP
product XAMPP which is very nice, but still not a whole 
system (from db definition to screen design to report writer)
that FileMaker and Access provide. (I presently use FileMaker
and have bid Access adieu.) I really want to do this in a
Linux environment and say goodbye to Windows, but 
without having to do the complex set up of multiple prod-
ucts that is required to emulate that sort of environment 
in MySQL or PostgresSQL and so on. Maybe you all could 
do a piece (hopefully not outside the charter of TUX) 
about complete, and maybe even integrated, database
development environments.

Thanks for bringing TUX to market. Even though I’m a longtime
computer user and wrestler with Linux, I’m still learning a bunch
for your publication.
--
Bill Cole�
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My best friend, Bunny, is always going on
about fashion. She is like the Bratz girls,
only not as smart. I do not like the Bratz
girls, but I like Bunny even if she is not so
smart and has OCD (obsessive compul-
sive disorder). Her OCD is funny. It does
not matter what we talk about. She
always has to use the word armadillo,
even if she has to make up a reason to
say it. Bunny tells me yesterday that
makeup comes from armadillos. She says
this when she tries to get me to wear
more makeup.

I do not need makeup, but when I
use makeup I use Clinique because other
makeup gives me allergy reactions. You
will not see me with my makeup unless
the famous TUX artist, Garrick, makes
another drawing with my makeup on. I
have only one drawing right now.
Garrick should make another so you can
flip back and forth between the two pic-
tures and I will go from Manga Mango
to Anime Mango. Do you know the dif-
ference? Manga is a Japanese comic.
Anime is Japanese cartoons. Manga uses

many drawings because it has many
pages. Anime uses at least two drawings
and much camera panning and zooming.

If TUX did animate me, I would want
to wear my high heels in the anime ver-
sion. I like to wear high heels and I do
not have trouble walking in them like
some girls do. I like them because I am
small. I cannot tell you exactly how small
I am because it depends mostly on the
size of your monitor or, if you like me on
paper, your printer settings. I really like
wearing heels because they make me
almost as tall as my boyfriend Otaku
unless he is piloting one of his Powerful
and Humungous Aggressive Robot
Thingies. I would need 30-foot heels to
be as tall as Otaku then. I think I would
have trouble walking in those. No,
Bunny, my high heels are not made from
armadillo leather.

I do not have any trouble answering
your questions because I am not only
beauty in a small package, I am a modest
and feminine Linux genius.

Q Dear Mango, I am new to the Linux
OS and I enjoy it very much. I enjoy

reading your column in every issue that I
receive. I also enjoy your humor and wit.

I need your assistance on upgrading
software applications that were installed
on my laptop when I installed a Linux OS. I
am using Ubuntu 5.04 with KDE. I would
like to upgrade to the latest versions of
various programs—that is, OpenOffice.org,
Gramps, Firefox and other various applica-
tions that were initially installed from the
installation disc.

When I use the Ubuntu Update Manager,
it will update various files and programs,
but it never seems to update the ones that I
want. I even updated the repositories/multi-
verse, but still, the installed version of the
various programs are the same as the latest
version, as listed in the Synaptic Package
Manager. Am I missing something here?

Is there a way I can upgrade these
programs easily to their latest versions? I
am sure that there are others who are
having this same problem. Can you help
us dear Mango?—Toivo

Q&A with Mango Parfait
Mango explains how to upgrade Ubuntu/Kubuntu, pick a distribution, synchronize
with a PocketPC armadillo and why not to call her kumquat. MANGO PARFAIT
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A Dear Toivo. Yes, you are missing
something. You are missing all the

latest software. But if I need to tell you
that, your question makes no sense. You
are smart to add multiverse. But that will
not get you the latest packages.

Here is the problem. Ubuntu and
Kubuntu have distinct releases with differ-
ent names. You are using 5.04. This ver-
sion is called Hoary Hedgehog. The new
version is called Breezy Badger. My best
friend Bunny says the next version will be
Angry Armadillo but I think this is another
thing she makes up. If the Ubuntu per-
sons want me to suggest a name for the
next version, I like Pickled Platypus.

Your package repositories use the
word hoary because you are using Hoary
Hedgehog. This is why you do not update
to the latest software. Your packages
come from the hoary repository, so you
are not finding the latest software. You
need to change your repositories to
breezy to get the latest software.

Here is an easy way to do that. Select
System→Administration→Synaptic
Package Manager from the desktop menu
to start the Ubuntu update manager. You
will ask, “Why do we use this instead of
the Ubuntu Update Manager?” The
Ubuntu Update Manager is not smart
enough to upgrade to Breezy Badger. The

Synaptic Package Manager is smart
enough, so that is what we use.

Select Settings→Repositories from the
Synaptic menu. You will see a pop-up

window like the one shown in Figure 1.
Click on the first repository and then

click the Edit button. You should see
something like Figure 2.
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Change the word hoary to breezy, like
you see in Figure 3, and click the OK button.

Repeat this for every repository in the
list. If the word hoary is part of a longer
word like hoary-updates, then just change

the hoary part to breezy like you see in
Figure 4.

When you are finished, click OK.
Maybe Synaptic will ask you if you want
to reload repository information, maybe it

will reload automatically. If
Synaptic asks, you will see a dia-
log box that includes this text:
“You need to reload the package
list from the servers for your
changes to take effect. Do you
want to do this now?” Click the
Yes button.

Now click the Mark All Upgrades
button in the Synaptic toolbar. You
may see a dialog box like the one in
Figure 5. Click the Smart Upgrade
button. Now click the Apply button
in the Synpatic toolbar.

Now it is time to read a book
or play a game on your
Playstation 2 or Game Cube. This
upgrade will download and install
maybe 1,000 files or more, and it
will take a long time.

No, I change my mind. Do not
go play a game. Sometimes when
you upgrade packages, the pack-
age will ask you a question.
Sometimes the question shows
up in a pop-up dialog. Sometimes
the question appears in a termi-
nal. But the Synaptic upgrade
window does not open a terminal
automatically. So if you see that

your upgrade is standing still for a long
time, maybe it is waiting for you to
answer a question in the terminal.

The upgrade window has a place
where you will see a triangle next to the
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Figure 5. Choose the Smart Upgrade
Figure 3. Changing to Breezy Badger
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word terminal. Click this triangle to see
the terminal. Answer any questions you
see in this terminal so that the upgrade
can continue. Then go play a game or
watch your favorite anime show.

There is one more thing I want to tell
you. You may see many warnings that
talk about your locale. Ignore these warn-
ings. They are not important. The
upgrade session will fix this problem
when it is maybe two-thirds done (maybe
more, maybe less). You will not see any
more warnings after that.

If you (Mr and Ms reader) are using
Kubuntu, you need to do basically the
same thing. Change hoary to breezy in
your repositories and then upgrade.

Q Hello Mango (may I call you
Mango?), I’m a noob Linux user who

is having a little difficulty finding the right
distro to call my home. I had started with
Debian and it was alright, but it didn’t
quite do everything that I wanted it to do.
Next I tried to move on to Fedora Core 4
and Mandrake, but they really didn’t work
out for me either. Now I’m hearing about
a new distro, Mandriva, which is supposed
to be a spin-off of Mandrake. Have you
had any experience with it, and if so, what
do you think of it for someone like me
who’s really looking to “walk the Linux
walk”?—Yardell

A Yes, you may call me Mango
because that is my name. If you call

me Kumquat, I will probably not answer
your question because I will think you are
talking to someone else. I can forward
your e-mail to Kumquat, but I do not
know anyone named Kumquat. So do not
call me Kumquat in your e-mail because I
do not know how to forward the e-mail
to her.

Everybody asks this question or a
question just like this one. They ask,
which Linux distribution should I use?
How can I answer this question? I do not
know who you are or what you like. I also
do not like this question because it is a
“love and hate Mango Parfait” question.
It does not matter which distribution I
recommend. If I recommend a distribution
people like, they will love me. If I do not
mention or do not recommend a distribu-
tion people like, then they will hate me. I
do not care. I am too pretty to care.

There is another reason I do not like
this question. Linux distributions
change. New ones show up. Old ones
get bad. Ask me this question again in
three months, and I will probably have
different answers.

You want to know about Mandriva?
The old version smells like rotten sushi.
There is a new Mandriva 2006 available.
You must pay to join a club to get the

new version. I joined the club for $132
US. There is a cheaper club membership,
but it is not a good one. Mandriva 2006
is okay, but it is not worth $132. One of
the Mandriva club Web pages tells me
that OpenOffice.org 2.0 is available. I try
to find out how to install it and the Web
site takes me to a page that tells me how
to add a software repository. It says I
should copy text from the Web pages and
paste it at a command line as root. It
assumes I know that I must change the
text to put in my password instead of the
word PASSWORD. For $132, it should not
tell me to paste a command at a root
prompt. It should do everything automati-
cally and serve me oolong tea while it is
busy. I am sure I can find out how to
install OpenOffice.org 2.0, but for $132 I
should not have to search for the answer.
I want my $132 back.

You also have to pay for SUSE. I will
try the new SUSE and tell you what I
think next month. Right now I do not like
SUSE. I can tell you why I do not like it
but it is better to try the new SUSE and
see if I like the new one first.

Now I will tell you what I think
about the other distributions I am using
and I like. Suppose you do not know
much about Linux and do not care that
you do not know Linux. Suppose you
just want to boot Linux and use appli-
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cations. Use Linspire. You must pay for
Linspire, but it does not cost as much as
Mandriva. If you want the easiest Linux,
then Linspire is worth much more than
the price. It is $59.95 US for the box or
$49.95 US to download it. Linspire does
not ask me to paste anything to a root
command prompt if I want to install
software. All I have to do is click a but-
ton. Maybe Linspire should cost $132
and Mandriva should pay me $59.95 to
use Mandriva 2006.

If you do not want to pay for Linux,
then download and install Kubuntu
5.10. This is the Breezy Badger version.
The next version will be Pickled
Platypus if the developers listen to me.
The next version is not ready so it does
not matter what they call it. Get the
Breezy Badger version. I think it is the
best free Linux distribution.

That is all you need to know, but I am
going to tell you more because I am in a
typative mood. I used to use Gentoo all
the time because it is fun, challenging
and it teaches me a lot about Linux. I do
not use Gentoo now. You have to com-
pile all the software yourself when you
use Gentoo. Lately I find that many things
do not compile. I am not complaining. I
use the most unstable version of Gentoo
so I do not expect everything to compile.
But I am tired of looking for the answers

when things do not compile. So I do not
use Gentoo anymore. I can use the stable
version of Gentoo if I want everything to
compile right, but I do not think this
makes sense. If I must compile everything,
then I want the latest software and the
stable version of Gentoo does not have
the latest software.

Now I use Kubuntu most of the time.
Debian is not as easy as many other distri-
butions, but I like it too. When I do not
use Kubuntu, I use Debian. Kubuntu is
based on Debian, but the Ubuntu and
Kubuntu people have changed Debian so
much that Kubuntu is not really Debian-
compatible. Sometimes you can make
packages designed for the original Debian
work on Kubuntu, but it is not always
easy. So when I need to run a program
that I cannot find for Kubuntu, I boot
Debian instead.

Kubuntu and Ubuntu are almost the
same. I think there are more differences
now with Breezy Badger than when they
were both Hoary Hedgehog. But they are
still mostly the same. Kubuntu uses KDE
and Ubuntu uses GNOME, but this is only
the default. Neither forces you to stay
with the default. You can install Ubuntu
and then install and use KDE. You can
install Kubuntu and then install and use
GNOME. I think you already know that I
do not like GNOME, so I do not recom-

mend Ubuntu. But do not be afraid to tell
me you like GNOME more than KDE. It is
good to tell me that. I hear there is a say-
ing that the first step to recovery is to
admit you have a problem.

Fedora Core 4 is very nice but I do not
like it as much as Debian and Kubuntu.
Right now the Fedora people are like the
GNOME people. The Fedora and GNOME
attitude is “We do not make it easy to do
anything your way because our way is
better.” The good thing is I do not think
this smelly attitude will last much longer.
Read the Fedora mailing lists. I think the
Fedora people see this smelly attitude
problem and want to fix it. Maybe Fedora
Core 5 will not try to be your boss like
Fedora Core 4 and earlier versions.

There are many other Linux 
distributions you can try. Go to
http://www.distrowatch.com with your
browser. It is a good place to find out
more about distributions. You might
find one you like that I do not like.
That is okay. You do not need to care
what I think. You are entitled to your
own opinion, even if it is wrong.

Q Dear Mango, I love your column 
in TUX magazine, although I have

read only a single issue. I hate the way
some are reacting to what and how you
write. Those people are closed to other
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cultures. It seems to me that you’re
Japanese, judging by the way you write,
but I cannot be certain.

I am using both Ubuntu and Windows
XP. I use a PocketPC PDA that keeps me
going back to XP to keep my device
synched (contacts, files and so on) and
whenever I need to install new applica-
tions. This is more like why people with
iPods start thinking to switch to Mac OS X
(a great OS, BTW). The question is: is there
any way I can synchronize my PocketPC’s
information and install applications in
Ubuntu?—Khalid

A You read only one issue? You need to
go back and read all of them. Twice.

I understand why you are not sure if I
am Japanese. You see my picture and
think, “Japanese manga girls have brown
hair, black hair, pink hair, blue hair, purple
hair, green hair, but they do not usually
have yellow hair. Some do but not many.
Maybe Mango Parfait is not Japanese.”
Maybe I can reassure you by reminding
you that my natural hair color is blue. I
dyed it yellow. Well, to be honest, I did
not dye it yellow. The artist at TUX did.
But do not wonder if I am not Japanese
because my hair is yellow.

I like Mac OS X too. Do you know it is
based on BSD? BSD and Linux are similar.

Why do you use a PocketPC? I have a

friend who uses Windows and writes
about Windows all the time. I remember
when he first got his PocketPC. He tried
to convince me it was the best. Guess
what happened when he showed me
how cool it worked? Windows CE
crashed and he had to restart it. Maybe
your PocketPC does not crash and you
like it. Maybe it crashes and you like it
anyway. I do not know because you do
not tell me.

You can synchronize your PocketPC
with Linux with Ubuntu. I assume you
want to synchronize your information

with Evolution because you are using
Ubuntu, not Kubuntu. So I will give you
those instructions. If I am wrong, remem-
ber what they say about people who
assume. “They might be wrong.”

Here is how to install the software you
need on Ubuntu 5.04 (Hoary Hedgehog).
If you have the latest Ubuntu, the instruc-
tions may be a little different but I am
certain you can adapt these instructions.

Select System→Administration→Synaptic
Package Manager from the GNOME
menu to start the Synaptic package
manager. Click the search button on the
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toolbar and search for the word “multi-
sync”. Click on the install boxes for the
packages multisync, libmultisync-plugin-all
and synce-multisync-plugin. Synaptic
should look something like Figure 6 when
you are finished.

Click the Apply button on the
Synaptic toolbar. Now search again,
this time for synce. Click on the install
boxes for synce-serial and synce-dccm,
like I show you in Figure 7. Click the
Apply button. Synaptic will ask you
about the connection to your PocketPC
when it installs synce-serial. If you con-
nect your PocketPC using USB, you can
keep the default values. Exit Synaptic

when everything is installed.
Now select Applications→Accessories→Multisync from the

GNOME menu to start Multisync. Click the New button on the
toolbar. Select SynCE Plugin for the first plugin. Select Ximian
Evolution 2 for the second plugin. You should see something
like what you see in Figure 8.

Click the OK button. I hope you are ready to synchronize your
PocketPC with Evolution now. Try it. I do not have a PocketPC so I
cannot test it for you.

There is a better project called OpenSync, but the last time
I looked it used Multisync and is not easy to configure or easy
to use, especially if you want to synchronize with KDE. So I
hope I am right that you are using Evolution, and I hope this
works for you.�

I am a sweet, humble, delicate and very cute genius who is at your 
service to answer your Linux questions. Send your questions to 
mango@tuxmagazine.com. I am deeply sorry that I do not have time to
respond to anyone directly by e-mail, but I will select as many questions 
as I can and answer them here.

P2P
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Figure 7. Install More SynCE Software

Figure 8. Set Up Multisync to Sync PocketPC with Evolution
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TUX: What’s your name, age, location,
occupation and role in KDE development?
My name is Daniel Molkentin, I live in Bonn,
the former capital of Germany, situated in
the lovely Rhine area. My primary involve-
ment with KDE is Kontact, the KDE group-
ware application. I am also involved with the
port of KDE to Qt 4, which eventually will
result in KDE 4.

TUX: What is the driving force behind 3.5,
features, speed or usability?
All of the above. There have been a lot of
usability improvements lately, especially in
the KDE panel, called Kicker, and in most
parts of Kontact. The openusability.org guys
are doing an awesome job in constantly
creating new reports that we can base
improvements on.

And features—well, they always add up
during a release cycle. There are so many, I
can name only the most prominent:
Konqueror has not only greatly advanced in
rendering, but it also features multiple search
engines, a pop-up blocker and an ad blocker.
Moreover, the KDE instant-messenger Kopete
comes with several new features and
improvements, among them MSN Webcam
support and support for the Yahoo! address

book. KControl got the last face lift—search-
ing for keywords is now more intuitive. This is
the last overhaul before it will be retired in
KDE 4 and replaced by something new.

As for speed—due to the natural way
library code gets optimized and some selec-
tive analysis with high-class open-source
memory and runtime analyzers, we were able
to push for speed here and there.

TUX: Everyone keeps talking about 4.0.
Are any planned 4.0 features in 3.5, or is
it more of a clean and final release for
the 3.x series?
The latter really. The panel has received some
eye-candy for the 3.5 release, but that’s still
not close to what we are working on for KDE
4. I think there are enough features in KDE
3.5 for now. If you want KDE 4 features, well,
hold your breath for KDE 4.

TUX: There were claims about the large
speed benefits that will come from Qt 4,
have you guys had much of a chance to
play with it and verify this?
Yes, it is true. So far we have mostly
worked on a Qt 4 port of the KDE libraries,
which already feels much faster, although I
don’t have concrete numbers right now.

SSnneeaakk  PPrreevviieeww::  KKDDEE  33..55
With recent beta releases of the upcoming KDE 3.5, we took the time to
catch up with one of KDE’s leading developers, Daniel Molkentin.

JOHN KNIGHT

Even the humble old backdrop gets an
overhaul in the new KDE!

The new-look opening screen for
Konqueror.

“First and foremost, KDE 
has succeeded as a desktop
environment, and that is
probably the most important
thing to note.”
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Also, there are a lot of optimization oppor-
tunities in the KDE libraries, which we will
certainly seize. This should allow for further
speed ups. A third point includes speed
improvements if you’ll be using the upcom-
ing X.org 7.0, which allows you to make
sure that almost all graphics effects are
performed on the graphics card rather than
on the processor. Current X.org releases
are not capable of accelerating complex 
2-D operations. Because KDE uses those
complex operations a lot, it will use less
CPU with new versions of X.org and there-
fore feel snappier.

TUX: Where do you feel KDE has to
improve to gain more users?
KDE for sure is already a very powerful and
versatile product. Not only do people use KDE
but they regularly tell us how much they like
it. Still, we recognize that there is a lot of
room for improvement, as KDE still suffers
from the complexity that has grown with the
amount of features it has.

We will try to make sure users can enjoy
the desktop environment and the applications
for what they are, tools—daily tools. For KDE
4, we plan to optimize work flow and make
sure users can still adapt KDE to their needs,
without getting lost in a jungle of options.
We are currently developing new concepts
together with our usability experts.

TUX: Where do you think KDE has partic-
ular strengths? Are there any areas that
you’re particularly proud of?
First and foremost, KDE has succeeded as a
desktop environment, and that is probably
the most important thing to note. But we
also have a lot of shiny pearls in our stack
of applications. Kontact and the KDE PIM
applications certainly belong among them,
allowing for interaction with a lot of pro-
fessional groupware servers. At the same
time, Kopete has grown to be a great mul-
tiprotocol IM application.

The edutainment project also contains
some very valuable applications—from
entertaining applications for children, like
blinKen, to applications that astonish even
professionals. Kalzium, our chemistry 
application got feedback from renowned
universities, and KStars, the KDE desktop
planetarium, can control your telescope.

Finally, there are a lot of fine external
KDE-based applications that are not
released with the KDE core packages, but
still shouldn’t be missed on any desktop.
There is amaroK, the flexible multimedia
player, and there is digiKam, the most flexi-
ble tool for digital cameras available on
Linux today, to name only two of them.
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Science nerds rejoice! Chemistry made
easy with Kalzium.

KDE is becoming a child’s intuitive learn-
ing environment with blinKen.

“I’d like to have it be seen
as the desktop that made
people love migrating to
Linux, in the first big wave 
of Linux migrations.”
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TUX: During the last few years,
there has been a lot of emphasis 
on cooperation with GNOME. Are
there any more parts of shared
work in 3.5?
The accessibilities teams of both proj-
ects have declared a close cooperation.
There are already approaches in 3.5,
but the fruits of cooperation will be
earned in 4.0. You will likely see more
cooperation via freedesktop.org wher-
ever we feel there that it would make
sense to cooperate.

TUX: Around 3.3, Apple was making
many improvements to Konqueror
for its Safari browser. Is there still 
a lot of Apple involvement with
Konqueror?
Since the time they opened up their
repository, it got quite a bit easier to
merge patches back and forth.
Although we still don’t have a grand
unified repository, it’s still a good 
move for us. That said, such a unified
repository is technically impossible at
this point.

Furthermore, we had two people
from Nokia at our developer meeting
“aKademy” in Spain. They presented

their porting work on KHTML/WebCore
to the Series60 platform and
announced to cooperate with our
developers, so there is hope for 
further contribution.

As kind of a “neutral zone” for all par-
ties involved, khtml.info (http://khtml.info)
has been founded.

TUX: What do you feel are KDE’s
strong advantages over Windows
and Mac OS?
KDE is its own platform, that’s what
makes us so flexible in most parts. The
only weak points are where we need to
interact with other projects like X.org
or the kernel, and we are trying to
resolve that. In the case of X.org, we
have already made quite significant

progress. It is also more flexible when it
comes to fulfilling users’ demands for
desktops that suit them. Neither
Windows nor Mac OS X make it easier
to make the shoe fit most users’ feet.

TUX: What would you most like the
3.x series to be remembered for?
I’d like to have it be seen as the desk-
top that made people love migrating 
to Linux, in the first big wave of Linux
migrations.

I think we also owe a great share to
the community here, because it was
the community that created lots of nice
applications and artwork for KDE.

TUX: Thanks for you time, Daniel.
Thank you for your interest.�

John Knight is a 21-year-
old, rock-climbing, Japan-
loving megalomaniac, try-
ing to take over the world
from his bedroom via his
keyboard. He spends
most of his time tinkering
with MPlayer and head-
banging to his MP3s.
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“There have been a lot of
usability improvements
lately, especially in the KDE
panel, called Kicker, and in
most parts of Kontact.”
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klik is a system that provides an easy way to down-
load and run software for KDE (http://klik.atekon.de).
It’s a simple way to try out the latest applications,
and when you’re finished with them, uninstalling is
as easy as dragging them to your trash can. klik pro-
grams are distributed as a single image that contains
all of the application’s libraries and other compo-
nents. This is rather like the way most software is
distributed on Apple’s OS X. klik introduces a new
URL schema, klik://myapp. These simple URLs are
understood by klik to mean “Fetch me the latest
version of my app from the klik servers.” Once
you have the klik client installed, you could type
klik://skype into the Konqueror address bar to grab
the latest Skype package.

HOW DOES KLIK WORK?
klik focuses on application bundles that contain all
the basic libraries needed to execute the program.
Assuming you’re using a recent Linux distribution,
there should never be any need to track down and
install dependencies for klik packages. These bun-
dles are usually created “on the fly” when you click
on a klik URL. Effectively, you’re requesting the
server for a recipe to make an application bundle
for your particular Linux system. klik then down-
loads all the files it needs, which are combined into
a single image file on your desktop with the file
extension .cmg. When you install the klik client, it
also installs the necessary support for Konqueror to

recognise these .cmg files and to know to pass
them onto klik when you click on them.

ADVANTAGES OF KLIK:

� Once the klik client is installed, installing
applications is a point-and-click process that
doesn’t require root privileges.

� klik is separate from system packages, so it
allows users to test out applications without
overwriting their stable versions.

� Uninstalling applications is as simple as drag-
ging the cmg image file to the trash can.

� By packaging dependencies with the application in
a bundle, users are saved from “dependency hell”.

� Applications can be relocated easily. Copy the
.cmg file to a USB key, CD or any other place
on your computer.

DISADVANTAGES OF KLIK:

� There is no signing implemented yet, so the
packages come from an untrusted source and
could possibly contain malicious code.

� klik packages, at this stage, don’t undergo

much of a quality-control process.

� Portability—Linux distributions can vary wildly,
making it difficult to package applications that
will work on all systems. This means in the early
stages of klik you’ll probably encounter pack-
ages that won’t work on your system.

WHICH DISTRIBUTIONS SUPPORT KLIK?

� Kanotix BH 8 and newer (http://www.kanotix.net).

� Knoppix 3.7 2004-12-08, 3.8 CEBIT and newer
(http://www.knoppix.de).

� Ubuntu 5.10 Breezy Badger Live CD, beta
(http://www.ubuntu.com).

� Linspire Five-0 (http://www.linspire.com).

� Kanotix CPX-MINI (http://debian.tu-bs.de/project/
cpx-mini/index.html).

� Debian sarge, sid (some .cmg files might fail
to run).

� OpenSUSE 10 (currently in preparation, some
.cmg files might fail to run).

� Fedora Core 4 (currently in preparation, some

kklliikk  aanndd  RRuunn
It’s a bird, it’s a plane, it’s Linspire’s Click and Run! No, it’s klik, a different approach to click-and-run applications.

JES HALL
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cmg files might fail to run).

Testing on distributions other than those men-
tioned seems to indicate that many of the most
popular packages will work on other modern dis-
tributions. I’ve tested some packages on SUSE
10.0, SUSE 9.3 and Slackware 10. Although not
all packages work on all distributions, support is
growing daily. Please note that the klik scripts
don’t handle path or filenames that have spaces.
What does this mean? If you create a folder for
your klik programs, you must make sure the name
of the folder doesn’t have any spaces in it. So,
rather than calling it klik Apps, call it klik_Apps.

HOW DO I INSTALL KLIK?
Installing klik is quite simple. Open the Run
Command... box that you’ll find in your KDE
menu, and type:

wget klik.atekon.de/client/install -O -|sh

This requires that you have the wget program
installed. If you get an error message saying,
“Could not run the specified command”, try
installing wget using your distribution’s usual
method for installing software from your install

media or the Internet. If for some reason this still
does not work for you, open a terminal window
and try typing the same command at the com-
mand-line prompt. For example, one person did
not get it to work at the Run prompt on Kubuntu
Breezy Badger, but it worked fine at a command
prompt on the same system. In this case, it prompts
you for your password to perform the next step.

Here’s the next step. You may get a dialog like
that shown in Figure 2.

You need to run the mentioned script to add
some entries to your fstab. What does this mean?

fstab is a file that lists various filesystems and
who is allowed to have access to them. klik needs
to be able to put some entries into this file to let
you have the access to “mount” these klik
images. They’re a little bit like a CD ISO image,
and to get at the files inside them, they have to
be mounted to a directory just like you mount a
CD-ROM to access it through a directory on your
computer. To run the script, you can use the Run
Command... box again. You should see the script
sitting in your home directory, on your desktop or
in your desktop directory. Drag the script over to
the Run Command... text entry box where you
would normally type a command. When you see
the mouse cursor change to signify that you can
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Figure 1. The KDE Run Command Box

Figure 2. This dialog may appear on installing klik.

Figure 4. Executing the Script as a Different User

Figure 3. Dragging a Shell Script to the Run
Command Box
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drop the object, release the mouse button. You
should now see text in the Command box.

Now, click on the Options button. Check Run as
a different user, and put your root password into
the Password box. If you’re using Kubuntu or
Ubuntu, you may have to put your own password
in there. This command takes only a second to run.

INSTALLING KLIK APPLICATIONS
While you’ve been doing this, klik should have
launched Konqueror for you and taken you to the
klik store. Here I’m going to walk through
installing and running the latest version of Opera.
It’s a pretty neat browser I’d like to try, but my dis-
tribution doesn’t package it. That’s okay though—
with klik, I can be up and running within minutes.

You can find Opera under the Contributed
kliks section. Simply click on the Opera image. A
security warning may appear telling you this page
links to klik:/opera. That’s not a problem though—
that’s exactly what we want!

A dialog appears asking you if it’s okay to down-
load a list of files. These are the separate ingredients

of the klik recipe that’s going to make up your
Opera.cmg file. Click Yes, and a dialog appears
showing you the download and install progress.

Once it’s finished, if the install was successful,
klik automatically launches Opera.

Well, that was pretty easy! The image has
been saved to your desktop, and whenever you
want to run Opera again, simply click on that
image file. Although installing the klik client can
be a little complex, some distributions are now
coming with the klik client pre-installed. If you’re
a little more Linux-savvy than your family or
friends, why not install the klik client if they’re
running a supported Linux version? They can

try out all kinds of software in a way that’s
easy, safe and fun.

One of the more interesting ways to use klik is
to try out the bleeding-edge pre-release software
that your distribution doesn’t usually package for
you. If they do, it sometimes means overwriting
stable versions of software and that’s not very
pleasant if the pre-release version is unstable.

Enter klik. Because klik application bundles are
separate from your system software, you don’t
need to worry about overwriting your stable ver-
sions. Because they’re self-contained, removing or
updating them is very simple. Figure 7 shows
Enlightenment DR17 running in a window on a
KDE desktop. This is the bleeding-edge develop-
ment version of Enlightenment, a window manag-
er with a lot of bells and whistles. Interested in
checking out the new eye-candy? Don’t want to
go through the hassle of learning how to get the
source code and compiling it?

KLIK://ENLIGHTENMENT
Once the klik bundle is downloaded to your desk-
top, simply click it to run. A lovely feature of this
particular bundle is that it has been designed to
run in a modified Xnest. In short, it runs in a sec-
ond, smaller X server within your own. This lets
you play with all the latest E17 features while still
being within the safety of your familiar desktop
environment. The particular X window it’s running
in can be resized, or you can even run it full
screen by pressing Ctrl-Shift-F.

A few other top picks:

� klik://realplayer10gold: the latest version of Real
Network’s versatile multimedia player for Linux.
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Figure 5. A Security Dialog

Figure 6. The Opera Web Browser, Installed via klik
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� klik://apollon: Apollon is a p2p file-sharing appli-
cation for Linux that can connect to the Gnutella
network (used by LimeWire and BearShare) and
FastTrack (Kazaa) as well as others.

� klik://nvu: Nvu is a cross-platform Web-

authoring system designed to rival FrontPage
and Dreamweaver.

� klik://ar7l: Adobe’s official Acrobat Reader 7
client for Linux.

� klik://opera9: the latest unstable version of the
Opera Web browser.

� klik://skype: Skype is an excellent cross-platform
peer-to-peer voice service, letting you talk to
your friends on Windows, Macintosh and Linux.

� klik://flock: the developer preview of the new
Mozilla-based Web browser, Flock. Flock focuses
on community and sharing, with integrated sup-
port for del.icio.us, a shared bookmarks service
that lets you share your favourite links with your
friends, and Flickr, one of the most popular on-
line services for posting photographs. It also has
integration with many major blogging Web sites.

klik is a relatively new technology, but it looks
very promising. There is preliminary support for
GNOME- and Mozilla-based browsers in the works,
so GNOME users can get in on the action too. If
you have trouble getting klik running, don’t
despair! Kanotix (http://www.kanotix.com/
index.php?&newlang=eng) is a live CD distribution
that comes with the klik client pre-installed, and
CPX-MINI (http://www.informatik.hu-berlin.de/
~bading/cpx-mini) is designed to run from a USB
key, also with klik pre-installed. To learn more, visit
the klik Web site (http://klik.atekon.de), or if you’re
IRC-savvy, you can find the developers hanging out
in #klik on freenode.�

Jes Hall is a UNIX systems consultant
and KDE developer from New
Zealand. She’s passionate about
helping open-source software bring
life-changing information and tools
to those who would otherwise not
have them.
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Figure 7. Enlightenment Running in a Window within KDE

klik://apollon:
klik://nvu:
klik://ar7l:
klik://opera9:
klik://skype:
klik://flock:
http://klik.atekon.de
http://www.kanotix.com/index.php?&newlang=eng
http://www.informatik.hu-berlin.de/~bading/cpx-mini
http://www.tuxmagazine.com


TUX EXPLAINS

29www.tuxmagazine.com

This month, we look at Window Maker, a desk-
top that’s been around for years, but has lots of
cool features and a unique interface that still
wins quite an audience. If you’re accustomed
only to environments like KDE, GNOME and
Windows, Window Maker (WM) will seem quite
strange, but don’t let that put you off, the low
level of clutter and the high level of customiza-
tion makes for a very likable environment. WM
also tends to be a fairly keyboard-oriented
desktop, so if you’re into keyboard shortcuts,
WM might be right up your alley.

LOOKING AROUND
In the top-left corner is the Clip, which is as close
as you’ll get to a Start Bar/Kicker. The Clip switch-
es between desktops (or workspaces as they’re
called here) and organizes icons. In the top-right,
are three icons, from top to bottom: WMDock,
xterm and Window Maker Preferences. See Figure
1 for an example of a default desktop for
Window Maker.

WMDock docks applications into manageable
boxes along the screen, and it is always running
by default. The xterm button runs a terminal, and
the Window Maker Preferences runs an applica-
tion to customize WM. We show you how to use

all of these, but only the basic functions, as we
don’t have space for every feature.

MENUS
To use the menu, right-click on the desktop and
hold down the button, the menu now appears,
and you can browse through it to your heart’s
content. See Figure 2 for an example of a cus-
tomized menu and desktop. To run a program,
simply highlight a menu entry with your mouse
pointer and let go of the mouse button; you’ll
also notice that when you open a program, a
new box appears, either in the top or bottom
left-hand corner.

Middle-click on the desktop, and a list of all
the open applications appears, including programs
running on other workspaces. The menus in WM
have some nifty features too, like hanging around
for multiple uses and breaking into parts. To make
a menu stay, hold the mouse button down and
release it while it’s over the menu’s title bar. To
make the menu disappear, either run an applica-
tion or left-click on the title bar. A cross now
appears on the right of the title bar, and clicking
on the cross makes the menu close.

You can do this with multiple menus, which
can be broken up too. Try going into one menu—

let’s use Games for this example—and apply the
previous steps to Games’ title bar. You now will
have both the original menu and the Games
menu open. If you left-click and drag Games’ title
bar, you’ll find that they’re now separated and

WWiinnddooww  MMaakkeerr  IIss  aa
PPoowweerrffuull  DDeesskkttoopp  LLiittee
Lightweight Window Manager Window Maker has unusual but
powerful features that might woo you away from GNOME or KDE.

JOHN KNIGHT

Figure 1. A Default Configuration of the Window
Maker Desktop

Figure 2. The Cascading Menus of Window Maker
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you have two menus that are snapping to each
other. If you’re going through a menu and decide
you want to get out of it without running any of
the programs that are listed, simply move your
mouse away from the menu and let go of the
mouse over the desktop.

WINDOWS
To maximize a window, right-click on the title
bar and choose Maximize. Minimize is called
Miniaturize in WM, and is a lot easier than
Maximizing; simply click the box icon on the left
of the window’s title bar, and the window now
shrinks into a box in the corner. To restore the
window, double-click on the new icon, and
Bob’s your uncle.

There are a number of options available when
you click on the title bar, and some have strange
names for functions that you are already used to.

Shade hides the window’s contents and dis-
plays only the title bar—double-clicking the title
bar has the same effect. Select, well, it selects the
window (I’m sure that would be useful some-
where down the line). The submenu Move To
moves the current window to another workspace.
Close speaks for itself, and Kill allows you to
destroy the window if it has stopped responding.
Attributes allows many advanced options, like dis-
abling the title bar, full-screen maximization and
so on. There is a drop-down menu at the top that
lets you change options relating to different areas,
but the options are too many to be listed here
and aren’t needed for a beginner; however, feel
free to play with them at your leisure.

Under the Options menu are three options:
Keep on top, Keep on bottom and Omnipresent.
Keep on top means that no matter how many
windows you open, the current window always is

at the front. Conversely, Keep on bottom means
the current window always is underneath.
Omnipresent is handy—usually called sticky under
other window managers, Omnipresent makes the
window visible on all workspaces. This can be use-
ful in situations such as having a music player run-
ning while you have lots of other windows spread
across multiple workspaces. Omnipresent means
you can access the player no matter which work-
space you are in.

CLIP
WM’s Clip is the most integral part of the desk-
top; it allows you to switch between workspaces,
determine icon behavior and so on. You’ll notice
arrows in two of the corners; click on these to
switch between workspaces. At the top is the
workspace number, with 1 being the main work-
space. At the bottom is the name of the work-
space, with 1’s name being Main.

If you right-click on the Clip, a menu appears
with all of the Clip’s options.

The first is Rename Workspace, which does
exactly what it says. This is handy for assigning a
task name to a particular workspace, like Audio,
Business and so forth. Next on the list is Selected;
this is not used for the Clip, but is for the icons
that have gathered around it. When you right-
click on the icons and choose Selected, it lets you
choose multiple icons and perform a single action
on all of these icons simultaneously (like move to
another workspace). Select All Icons is the blanket
version of Selected, automatically selecting all of
the icons at once.

Keep Icon, Attract Icons and Remove Icon all
relate to one another. Remove Icon detaches it
from the Clip and sends it to the bottom of the
screen, Attract Icons brings them back and any

other icons that are on screen, and Keep Icon tells
them to stay where they are. Launch is interest-
ing—use it on an icon, and a second instance of
the program runs. Hide minimizes the window
represented by the application, and the now-pre-
sented Unhide option restores the window.

Moving on to the two submenus—Move Icon
To simply allows you to move whichever icons are
selected at the time to a workspace of your
choice. Clip Options is more complicated, as it
determines a number of behavior areas. Keep on
Top decides whether the Clip is always visible. Do
you want it there when you have a maximized
window? Or would you prefer to keep in the
background, out of the way? Collapsed simply
sucks all of the icons into the Clip so that
they’re not visible. Autocollapse makes it do
this automatically in the future, and Autoraise
does the opposite.

WINDOW MAKER PREFERENCES
We don’t really have room to go into the whole
operation of the Preferences utility; therefore, we
cover only the coolest and most important parts
of it—you can explore the rest for yourself. Open
it by clicking on the Window Maker Preferences
icon (the one with the screwdriver) in the top-
right of the screen.

The first good thing to do is turn on balloon
help; simply click in the box on the bottom left of
the new window to turn it on. Now, when you
hover your mouse pointer over a feature, a small
dialog balloon appears, telling you what it does.
Try the Icon Preferences section, which is the
fourth box from the left, at the top. Here, in the
icon positioning section on the left, you can desig-
nate where new icons will be created automatically
(normally at the left). On the bottom right is the
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icon size option: normally each icon is 64x64
pixels; if they’re too large, feel free to turn them
down. I like 48x48, but this probably won’t work
until the next time you start WM. The Iconification
Animation part is cool too—try changing it to
3D-flipping and notice the difference when you
minimize a window!

My favorite section is the Workspace
Preferences section, which is the seventh box from
the left. On the right are two options, the top is
for disabling/enabling the Dock, and the bottom is
for disabling/enabling the Clip. On the left is the
neat part, with three options. The first is the

option wrap work-
spaces. This means that
when you’re scrolling
between workspaces
and you come to the
last one, if you keep
scrolling, you’ll go back
to the first—and vice-
versa. The second
option is my favorite,
when you drag a win-
dow off the side of the
screen, it scrolls
through to the next
workspace and drags
your window there too.
Turn it on, click Save
and try it out!
Automatically create
new workspaces, is the
last option. If you scroll
past your last work-
space on the Clip, a

new workspace is created. This can be good, but
it also can be annoying when you accidentally
make four new workspaces that you didn’t want,
so be careful (you can destroy these later by
choosing Destroy Last from the main menu under
Workspace→Workspaces).

If you scroll the bar below the boxes to the
right, the icon with the picture of the keyboard
has the shortcut key options—definitely worth
examining. The icon with the mouse picture
allows you to change which mouse button does
what, and the icon with the big F lets you change
the main font used.

THEMES AND DESKTOP CUSTOMIZATION
WM is easily themeable, and there are a lot of
options available, my favorite being the Bjork
theme (shown in Figure 4). If you download a
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Figure 3. Window Maker Preferences

Figure 4. Bjork, My Favorite Theme for Window Maker

Figure 5. Using Konqueror to Browse Themes

http://www.tuxmagazine.com


theme and are not sure how to install it, extract the
file with your favorite archiving program (perhaps
ark) and copy the new directory and its contents
to <your home directory>/GNUstep/Library/
WindowMaker/Themes.

To change to your theme, simply 
browse through the desktop menu under
Workspace→Appearance→Themes. The desktop
background can be changed too, simply copy
your favorite pictures to <your home directory>/
GNUstep/Library/WindowMaker/Backgrounds.
To use your new background, access it under
Workspace→Appearance→Background→
Images with the desktop menu.

DESKTOP ICONS
When it comes to a desktop file manager and
icons, most choices are unsuitable, due to
WM’s reliance on the right- and middle-mouse
click, but Rox is a good choice, and the combi-
nation with WM feels good. To use Rox, you
first have to make a new file called autostart
under this directory: <your home directory>/
GNUstep/Library/WindowMaker/.

In the new file, enter the following text:

rox --pinboard=Default &

The autostart file now has to be made exe-
cutable. If you’re using Konqueror, right-click and
choose Properties. Click on the Permissions tab,
and check the Is executable box. Under Nautilus,
do the same, but in the Permissions tab, check
the Execute box in the Owner section.

The next time you start WM, Rox will be
running its Pinboard over the desktop. See

Figure 6 for an example of Window Maker 
running with Rox.

You will notice a side effect or two if you use
Rox. See how you can’t use WM’s desktop menus
anymore? To combat this, right-click on the Rox
Pinboard and choose Rox-Filer→Options. Choose
Compatibility from the menu on the left, and
check the box for Pass all backdrop mouse clicks
to window manager under Window manager
problems. This enables you to access WM’s right-
click desktop menus again, but with two more
side effects:

1. The menu always disappears when you release
the mouse button. This means that you can’t
do some of the cool things like breaking up
menus and leaving a menu lingering on the
desktop, but for many users these features may
be superfluous anyway.

2. You can’t access the Pinboard’s right-click menu
anymore. This is most useful for quick access to
the Rox Options menu, but it still can be
accessed by right-clicking under the Rox File
Manager. If you want the Pinboard’s menu back
temporarily (perhaps for changing the back-
drop), make your way back to the Window
manager problems section, turn off the option
you checked and click OK while you perform
whichever task you want to perform. (See the
Rox documentation for more info.)

All in all, WM is a unique desktop that has
many dedicated users. The boxy feel will either
turn you on or put you off, and many people love
the way all of the features of this desktop are
contained in a few simple components, making
this a deceptively feature-laden desktop.�

John Knight is a 21-year-old, rock-
climbing, Japan-loving megaloma-
niac, trying to take over the world
from his bedroom via his keyboard.
He spends most of his time tinker-
ing with MPlayer and headbanging
to his MP3s.
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Figure 6. Window Maker Rox

RESOURCES

Central Web Site: http://windowmaker.org

Themes: http://themes.freshmeat.net/browse/1091
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In the August 2005 issue of TUX, I said, “You can customize KDE so that you
can right-click on a .vbs file and choose Actions→Compile, which launches a
compiler specifically for Visual Basic Script. This option will not show up for
other types of files. You cannot do the same thing in GNOME. I can explain
how to do all this in KDE. Maybe I will explain in a future issue.”

This is the future issue. I am not going to show you how to compile scripts.
I am going to show you how to customize KDE so you can right-click on a
Microsoft Word document and view the document in a browser as HTML.

I am going to tell you that, but this article is not really about how to view
Microsoft Word documents as HTML Web pages. This article is about how to
make your own custom actions for KDE Konqueror. Maybe you do some-
thing many times a day. Maybe you do something like move documents to
the same place or convert one file into another type of file. You can use this
trick to make it easy in KDE.

I use this ability to view Word documents as HTML as an example of what
you can do. I hope you will learn from the example so you can create your
own custom menu actions. Most of what I will tell you is easy. The hard part
is learning how to make commands like the one we will use to change
Microsoft Word documents to HTML. If you decide to use this trick but do
not know how to create the command for what you want to do, maybe you
can get a geek friend to help you.

ONCE UPON A TIME
Here, maybe this makes more sense if I make up a story. You have many
Word documents in your folders. You tell your geek friend that you want to
look at these documents many times, but you do not want to open them in
a word processor. You don’t want to make changes. You don’t want to wait
for a word processor to load. She says, “First download this package. It is

called wv or wvWare. It may be called something else for your distribution.
Here is what it looks like in the Kubuntu 5.10 Breezy Badger Adept package
manager.” (See Figure 1.)

AAdddd  CCuussttoomm  AAccttiioonnss  ttoo  YYoouurr
KKDDEE  KKoonnqquueerroorr  PPoopp--uupp  MMeennuuss
How to set up Konqueror so that you can right-click on an icon for a Word Document and view that document as HTML.

MANGO PARFAIT

Figure 1. Install wv using the Kubuntu Adept package manager.
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So you start the Adept package manager. You search for wv. You find the
package. You click the Install button. You click the Commit Changes button
in the toolbar. Now you have the wv package installed.

Then your geeky friend tells you, “Type this command to create a tempo-
rary directory in your home directory. You need this because sometimes
when you convert Word documents to HTML you create a lot of files. You do
not want to clutter up your directory with these files”:

$ mkdir ~/tmp

She says, “Now, here is the command to convert the Word document to
HTML”:

$ wvHtml --targetdir=$HOME/tmp <the document name> temp.html

She continues, “Now open up the tmp folder in Konqueror, and then
click on the file temp.html. This is how you can view the Word document
as HTML.”

You say, “This is too much trouble. I do this many times a day. I do not
want to type commands. I want to open the folder, click on the icon for the
Word document and tell Konqueror to show me the document as HTML. I
do not know how to make the command work. You tell me the command
and I will put it in the right place and use it. I know how to do this because I
read the article by Mango Parfait.”

THE EASY WAY
Okay, so here is how to do all the work one time and then get what you
want, which is a point-and-click way to view the Microsoft Word document
in your browser as HTML.

First, you need to install the wv package (or whatever it is called for your
distribution). See the above example for how to install this with Kubuntu
Breezy Badger. If you are not using Kubuntu Breezy Badger, you need to fig-
ure out how to find this package and install it. If I tell you the steps for every
distribution, this article will be too many pages long.

You should create a temporary directory like your geeky friend says. You
can do this without typing a command. Open up your home folder. Right-
click on an empty space and select Create New→Folder from the pop-up

menu. Name this new folder tmp.
Now we are going to teach KDE how to show you the Word document in

HTML just by pointing and clicking.
Start your favorite text editor. My favorite text editor is Kate. I will tell you

what to do in Kate, and you can figure out how to do the same thing with
your editor if you do not like Kate.

Type the following text in your editor. Be very careful to type it exactly this
way. This is the most important part of the trick:

[Desktop Entry]

ServiceTypes=application/msword

Actions=ViewDocAsHTML

[Desktop Action ViewDocAsHTML]

Name=View Word Doc as HTML

Exec=wvHtml --targetdir=$HOME/tmp %f temp.html; konqueror ~/tmp/temp.html

If you have a little knowledge, you will wonder why I use $HOME in one
place and ~ in another place. They both mean the same thing, right? If you
do not know this, I can tell you that this is right. They both mean the same
thing. Both of these point to your home folder. But wvHtml does not under-
stand the ~ symbol. So I have to use $HOME instead. I can use $HOME later,
too, but I am lazy. The symbol ~ is one character. The name $HOME is more
than one character. I take the easy way when it works and use ~.

Are you sure you typed everything right? Good. Now you must save this
text file. It is important to save it in the right place. So select File→Save As
from the editor menu. You will see a file save dialog. You are going to save
this file in a folder that probably does not yet exist on your computer. Here is
the folder you need to use (change mangoparfait to your user name):

/home/mangoparfait/.kde/share/apps/konqueror/servicemenus

But the servicemenus folder is probably not there. So here is how you can
make this folder exist. Type this as the file save location (be sure to change
mangoparfait to the name of your home directory):

/home/mangoparfait/.kde/share/apps/konqueror/
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See Figure 2 for an exam-
ple of how it looks when
you use Kate.

Now we must create the
new folder. There is more
than one way to do this. An
easy way is to click on the
folder icon with the star on
it. This is the new folder
icon. You will see a pop-up

dialog. Type the name servicemenus in the dialog like you see in Figure 3
and click the OK button.

This creates the folder and changes to that folder when you use Kate. So
now you are ready to save the file. Save this file with the name view-doc-as-
html.desktop. See Figure 4 for an example.

Type the right name and then click the Save button.
You are done! Open up a folder where you have Microsoft Word documents.

Right-click on the icon for a document. Now select Actions from the pop-up
menu. You should see a menu selection called View Word Doc as HTML. So select
Actions→View Word Doc as HTML from the pop-up menu. You should see a new
Konqueror window open, and it will display the Word doc as an HTML file.

HOW IT WORKS
The servicemenus folder you made earlier is a special folder. If you put the
right kind of files in this folder, it will add actions to the pop-up menu for
Konqueror when you right-click on an icon. The file we put there is view-
doc-as-html.desktop. Do you see that it contains these lines?

[Desktop Entry]
ServiceTypes=application/msword
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Figure 2. Where to Navigate First with Save As

Figure 3. Name the new folder servicemenus.

Figure 4. Save this file as view-doc-as-html.desktop.
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The first line tells Konqueror what this file is for. Do not
worry about it, just make sure you start with this line [Desktop
Entry] when you make your own custom actions.

The second line tells Konqueror that this action is for
Microsoft Word documents. Right-click on an icon for some
other kind of file. Try a text file or a graphics image. Then select
Actions from the pop-up menu. Do you see View Word Doc as
HTML there? No you do not. Why? Because we told Konqueror
that this action is only for Microsoft Word documents. If you
read my words above that I said in the August 2005 issue of
TUX, you will see that this is the difference between GNOME
and KDE. You can create custom menu actions in GNOME, but
they will pop up no matter what file you pick. GNOME is not
smart enough to know that one action is for one file and anoth-
er action is for another file.

Now look at the next line:

Actions=ViewDocAsHTML

This tells Konqueror where to look in this file for the custom
action. You can have more than one action here, but I try to keep
this simple for you. This points to the heading that comes next:

[Desktop Action ViewDocAsHTML]
Name=View Word Doc as HTML

Konqueror will look here for the action. It will also see that
the name is View Word Doc as HTML. This name is what you
see in the menu.

Now here is the hard part. This is the action or command. It
is actually two commands separated by a semi-colon:

Exec=wvHtml --targetdir=$HOME/tmp %f temp.html; konqueror ~/tmp/temp.html

The wvHtml command converts a Microsoft Word document
into an HTML document. It is not a very smart program, so we
need to tell it some things. We need to tell it what directory to

use. That is why we have the targetdir part of the command.
Konqueror will replace the symbol %f with the name of the

file you have selected. This is the input file for wvHtml. Then
wvHtml will create the output file temp.html in the directory we
told wvHtml to use.

There are other symbols you can use. One example is %F.
Konqueror will let you select many icons in a folder and it will
send all the filenames to the place where you put %F. Be careful
if you try this. Many programs do not know what to do with
many filenames at once and your trick will not work. Here is a
list of some of the symbols for you:

� %f—the file you have selected.

� %F—multiple files you have selected.

� %u—a URL (like http://www.tuxmagazine.com).

� %U—more than one URL.

� %d—this is the directory for the file you have selected (%f).

Now look at the command line again. Next we have a semi-
colon. This tells Konqueror that we are done with the first
command and we want to start another command. This new
command opens up Konqueror and tells it to load the tempo-
rary HTML file. This is the easiest way I know how to make it
show you the file in HTML. I know harder ways. I know how to
make the file show up in the folder window where you have
the Word document. But that is too much to learn for one
day, so I keep it simple.

Like I say above, most of this is easy. The hard part is the
command. If you can do the rest by yourself, ask a geeky
friend to tell you what command you can put on the line
that starts with Exec=. Now you know how to make custom
actions for Konqueror and I told you in this future issue, 
just like I said.�
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I am a sweet, humble,
delicate and very cute
genius who is at your
service to answer your
Linux questions. Send
your questions to
mango@tuxmagazine.com.
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I got my hands on the latest version of Kubuntu,
5.10, dubbed Breezy Badger, and I’m extremely
impressed. If this were a review of Kubuntu, I’d
give it a hearty thumbs-up for just about anyone,
from newbie desktop users to power users. I’m a
fan of most distributions, but I’ve been using
Debian unstable simply because it’s so easy to keep
Debian up to date. Don’t be misled by the term
unstable. There’s no guarantee that packages from
the unstable branch of Debian will work properly,
but the unstable branch of Debian behaves
remarkably contrary to its name. I’ve rarely had a
problem with this branch, and when I do experi-
ence problems, they are often resolved the next
time I update the system (usually a matter of days).

Kubuntu won me over, however, and has dis-
placed Debian as my standard desktop. This should-
n’t come as a surprise to anyone who knows about
Kubuntu’s roots. Kubuntu is based on the unstable
branch of Debian. The Kubuntu/Ubuntu folks have
polished, enhanced and customized Debian unstable
to make it easier for the masses without dumbing it
down so much that power users can’t appreciate it.

I tend to go through the same basic steps to
customize a new KDE desktop, and as I was step-
ping through them, it occurred to me that TUX
readers might benefit from the processes I go
through. I ran this by the editor in chief, and we
decided to launch a regular series of experiences
“from the trench”. Within time, TUX hopes to

make this a monthly feature written by various con-
tributors who would like to share their experiences.

MOVING THE KDE PANEL
Okay, exposition done—on to the story. The first
thing I do after getting everything running is com-
pletely rearrange the KDE panels. The default
setup for Kubuntu is similar enough to the default
used by most modern distributions with a recent
version of KDE that most of what I change here
will be things I would change if I were using
another distribution.

It wouldn’t do much good to show you a
whole screen shot, because there isn’t much to
see. My system simply has a panel, a blank desk-
top and perhaps an icon for a CD inserted into
the DVD drive. The primary issue for me is the
panel. Figure 1 shows a compressed version of
what the default panel looks like in Kubuntu 5.10.

There isn’t a whole lot I don’t like about the
default panel—yet. One thing I don’t like is that it
appears at the bottom of the screen. I like to select
programs from a drop-down menu that appears at
the top of the screen. I don’t like GNOME itself, but
this is the default panel arrangement for GNOME,

and that much I like. I also like having the taskbar at
the bottom of the screen. I prefer having the desk-
top pager near the left on the top panel. GNOME
puts it on the bottom panel at the right by default.
But it’s easy to change that about GNOME, and it’s
easy to configure the KDE panel the way I like it too.

Anyway, the first thing I want to do is move
the panel to the top. I click on a blank area of the
panel and drag it to the top of the screen.
Problem solved.

TASKS CRUSHED AND MUTILATED
I like to add icons to the panel for those applica-
tions I launch most frequently. In my case, I most
often use Mozilla Firefox, Mozilla Thunderbird, the
Kate editor, the Kjots note taker, the Psi Jabber
client, the BasKet free-for-all information manager
and the Konsole (a command-line terminal pro-
gram). I also like to have an icon that lets me
choose between different Konqueror profiles so
that I can open up a Konqueror window for vari-
ous tasks. I want to add icons for each of these.
Some months ago, Mango Parfait mentioned a
trick where you can add drawers of icons to the
panel. This saves space because you can click on a
drawer that opens up into a menu of the applica-
tions you use most. I don’t like drawers, though. I
want all the icons right there on the panel.

I also like eight virtual desktops instead of the
default four, so I’m going to want to expand the
virtual desktop switcher you see on the example
panel in Figure 1.

FFrroomm  tthhee  TTrreenncchh
Ricky gets Kubuntu and leverages the experience to share some tips about customizing the KDE desktop.

RICKY FREEDLANDER

Figure 1. Default Panel for Kubuntu KDE
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Why am I telling you all this? Some of the mid-
dle of the panel is chopped out in the image in
Figure 1 so that you can see everything more
clearly. But there really isn’t much space chopped
out. My point is that if I start adding all these
icons to the panel and expand the desktop pager,
it will reduce the size of the taskbar too much.

KDE has a solution for this problem, but I don’t
like the usual default workaround. It’s a given that
the taskbar isn’t really big enough, so most KDE
default desktops will group similar tasks into a single
entry when the taskbar gets full. This means that if
you have several Firefox windows open, you will see
only one entry in the taskbar for Firefox. This single
entry in the taskbar will have an up arrow, which
tells you that it represents more than one window.
You click on the entry, and a menu of all the associ-
ated (similar) windows appears. You can select from
the list of open windows that pops up.

I don’t like this behavior for a variety of rea-
sons, none of which are necessary to list here.
Suffice it to say I want a taskbar that doesn’t have
to compensate for being narrow and unable to list
the many programs I have open.

So I delete the taskbar altogether. Don’t worry, it’s
going to a better place in a moment. Do you see
that little dotted vertical bar to the left of the
taskbar? I right-click on it and select Remove Taskbar
from the pop-up menu. Gone. Now I have plenty of
room for the icons I want to add to the panel.

I right-click on the empty space where the
taskbar used to be and select Add To
Panel→Application→Internet→Web Browser
(Firefox Web Browser). This adds an icon for Firefox
to the panel. I repeat this sort of thing to add icons
for the rest of my favorite applications to the panel.

One tricky addition to the panel is the
Konqueror profiles icon. In this case, I right-click
on the panel and select Add To Panel→Special
Button→Konqueror Profiles.

The one icon I deliberately do not add to the
taskbar is the one for the BasKet information
manager. I’ll explain why not, later.

Then I right-click on the desktop pager/switch-
er and select Configure Desktops from the pop-up
menu. I move the slider to give me eight desktops
(see Figure 2).

At this point, my top panel looks like what you
see in Figure 3. You might notice that I’ve moved a
few things around. I slid the Trash icon next to the
System icon and placed the pager after that. It’s just
the way I like things. The main thing to notice is
that I have all the icons I want, and room to spare in

case I want to add more. I actually have more room
than what is shown here. Once again, I cut out
some of the middle to make it easier to view.

A TISKIT A TASKET
Now, I want my taskbar back. I right-click on an
empty space on the panel and select Add To
Panel→Panel→External Taskbar. Voilà. A taskbar
appears at the bottom of the screen. It doesn’t
have to compete with icons or desktop pagers or
anything else for space. There’s plenty of room to
list all the tasks I have running.

Just in case, I right-click on the taskbar and select
Configure External Taskbar from the pop-up menu.
A window appears like the one you see in Figure 4.

Notice that it says Group similar tasks: When
Taskbar Full. I click on the drop-down control and
it gives me two other options, Always and Never.
I pick Never. I click the Apply and OK buttons, and
that’s that.

TUX EXPLAINS

38www.tuxmagazine.com

Figure 2. Set the Desktops to Eight

Figure 3. The Reconfigured Top Panel Figure 4. Configure the Taskbar Behavior
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VIRTUAL ESTATE
There’s one more thing I’m picky about when it
comes to desktops. I don’t want the panels to
take up too much desktop space, commonly
referred to as real estate. So I right-click on the
top panel and select Configure Panel from the
pop-up menu. There’s a size setting near the bot-
tom of the dialog box. I set the size to Small.

The only problem with this setting is that it
forces the virtual desktop pager to slip into single-
row mode. Instead of listing four desktops on top
and four on bottom, it lists a row of eight desk-
tops. This takes up too much space on the panel
for my tastes.

I right-click on the pager and select Show→
Rows→2. This turns it back into a pager with
two rows of four desktops. This configuration is
nice and small, so it takes up very little space on
the panel.

At this point, I’m happy with the results.
Everything is where I want it to be. The menu is on
top. The pager is on top. The icons for my favorite
applications are on top. The clock is on top. And all
the sizes are just right. I might want to shrink the
size of the taskbar at the bottom of the screen, but
I might not. Right now it doesn’t matter.

SENSITIVITY SESSIONS
Now, what about BasKet? I’ll get to BasKet like I
promised, but first I need to change the way KDE
handles sessions. I click on the System icon and
select Settings from the menu. I click on the KDE
Components icon, and then click on the Session
Manager icon. This brings up a dialog box like the
one in Figure 5.

I see that Kubuntu uses the common default.

Whenever I log in, KDE restores the previous
session. If I had a Konqueror window opened
when I logged out, it will open a Konqueror
window when I log in. Each to his own, but I
don’t like this. So I change the setting by click-
ing on the radio button for Restore manually
saved session. I click the OK button and I’m
done with that step.

Now, what about BasKet again? BasKet is one
of those programs that inserts itself into the KDE
system tray on the panel even after you close the
BasKet window. This way it’s always instantly
available at the click of a mouse. Once BasKet
takes its place in the system tray, it becomes part
of the current KDE session. Other programs work
this way too. Some instant messangers work this
way, as do some music players.

Here’s the trick. I start BasKet and then close
the BasKet window. Figure 6 shows what the sys-
tem tray looks like afterward.

Now I close all my applications—every one of
them. I select the first virtual desktop in the pager.
Then I click on the KDE start menu and select
Save Session from the main menu.

From now on, when I log in to KDE, it starts
with no windows open, and it remembers that I
was using the first virtual desktop. It will also have
BasKet running in the system tray on the panel.
Why? Because it was there when I saved the ses-
sion. I can do the same thing with programs that
work in a similar fashion, like amaroK (a music
player). If I save a session with amaroK in the sys-
tem tray, it will be there when I log in again.

At this point, I may select a different desktop
theme, customize some colors, choose my favorite
desktop wallpaper and set up the screensaver. But
I’ve made all of the changes that are most impor-
tant to me. I’ve maximized my screen “virtual real
estate”, and I have my KDE panels and desktop
looking and working exactly the way I like it.

Maybe your tastes differ vastly from mine.
Maybe you even like whatever default configura-
tion your distribution uses for KDE. But I hope
that this little story showed you some of the
things you can do to customize your KDE desktop,
and I especially hope you benefit from knowing
you can save system tray applications as part of
your sessions so that they will reappear in the sys-
tem tray when you log in again.�

Ricky Freedlander is a consultant and freelancer and has been
using Linux since 1995.
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Figure 5. Configuring KDE Sessions

Figure 6. BasKet is still running
in the system tray.
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In this last part of the Inkscape “Elements and
Principles of Design” trilogy, a composition is cre-
ated and submitted to the Open Clip Art Library,
an archive of user-contributed clip art that can be
used freely.

To construct this composition, Inkscape, an
open-source scalable vector graphics drawing tool,
is used to demonstrate both design concepts and
features of the application. This article also fea-
tures the newly released Inkscape version 0.43,
but the newest version is not required explicitly in
order to follow this article.

To recap, the elements of design are the basic
graphical components—point, line, shape (form),
texture and color—used to create a larger design.
The principles of design are basic guidelines—bal-
ance, rhythm, proportion, dominance and unity—
for making a larger arrangement of elements.
Thus, composition is the intersection of the ele-
ments and principles.

COMPOSITION
The combining of distinct elements to form a
whole is composition. This confluence of elements
and principles is closely associated with the psy-
chological idea of gestalt, which originated in
Germany in the 1920s, and which considers the

“relationship between the parts and the whole of
a composition” (see Resources). What follows
from understanding the gestalt of something are
ideas such as closure and continuance, discussed
in the November 2005 issue, as one’s mind filling
in the missing pieces of a composition and per-
spective, respectively.

THE PROJECT: LOGO AND LETTERHEAD
Rather than create a typical landscape or portrait
painting, the focus of this article is to make a
generic letterhead with a generic logo for a
generic business, using the elements and princi-
ples to make a composition.

In graphic design it is helpful to have some
goal. For this project, the goal is to create a soft
representation for the client (who we are doing
this work for) of a human resources company that
appeals to the common person. The client needs a
nice letterhead that can be re-used throughout a
thousand-person company.

Start Inkscape on your computer and select
the Document Preferences Palette under
File→Document Preferences... (Shift-Ctrl-D). Make
sure that the page size is set to A4 (or US letter
depending on where you live). If you are more
familiar with Imperial units, select “in”, for Inches

in the Default units option (see Figure 1).
Next, click the Metadata tab in that dialog.

Now enter data into the fields. This metadata, or
data about data, will be used when we submit

IInnkkssccaappee,,  PPaarrtt  IIIIII::  CCoommppoossiinngg  
ffoorr  tthhee  OOppeenn  CClliipp  AArrtt  LLiibbrraarryy
Create this or your own composition with Inkscape and upload it to the Open Clip Art Library.

JON PHILLIPS

Figure 1. Document Preferences Dialog
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this file to the Open Clip Art Library. It is used to
describe the document we are creating, which
helps with organizing and searching files created
with Inkscape. Also, because this is to be submit-

ted to the Open Clip Art Library, make sure to
select under the Licenses pop-up menu, public
domain. The Open Clip Art Library accepts only
imagery that is put into the public domain. An
example of the types of data entered is shown
in Figure 2.

THE LOGO
To create the logo, let’s create a generic person.
First, use the ellipse tool (F5 key, Figure 3) to cre-
ate a head. Hold the Ctrl key down while drag-
ging on the drawing area (canvas) to constrain the
shape to a circle. Next, change to the rectangle
tool (F4 key, Figure 4) and draw a body for this
head including arms (Figure 5). Use the auxiliary
controls for the rectangle tool to make the rectan-
gle have rounded edges (Figure 6).

Next, create a smaller slice that represents the
gap between the person’s arm and body, as exem-
plified in step 3 in Figure 5. Duplicate this shape
while it is selected with the selection tool (Figure

7) and by choosing in the menu, Edit→Duplicate
(Ctrl-D). Drag this duplicate over to represent the
secondary arm gap.

Now, to remove these gaps from the rectangle,
select the first gap, and then Shift-click the body
part. Then, in the menu, choose Path→Difference
(or press the Ctrl and - keys at the same time).
Then, repeat this step on the second arm gap. If
the proportions are not correct, undo the last few
steps, reposition the forms and continue.

Finally, using the edit/node selection tool
(Figure 8) select the bottom two points of the per-
son’s body and drag downward while holding the
Shift key as shown in the fourth step of Figure 5.

The next steps involve duplicating this figure in
90 degree increments, demonstrated in Figure 9.
First, duplicate the newly constructed person figure.
Then, under the Object menu, Object→Flip Vertical
(V key). In Inkscape, the shape should still be select-
ed. Now, hold the Shift key down and use your key-
board’s down-arrow key to move this duplicate per-
son downward until it looks as if it is one mirrored
person like in Figure 9, step 2. Select both of the
shapes with the selection tool and use the menu
item, Path→Union (Ctrl-+), to join the shapes.
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Figure 2. Document Preferences Dialog’s
Metadata Tab

Figure 3.
Ellipse Tool

Figure 7. Selection Tool

Figure 8. Edit/Node Selection Tool

Figure 6. Rectangle Auxiliary Toolbar

Figure 5. Steps to Creating Logo

Figure 4.
Rectangle Tool
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To create the other parts of the logo, first
duplicate the last creation. While the duplicate is
selected, go to the menu and choose
Path→Rotate 90 degrees CW (clockwise). Then,
select both pieces and union them together to
have a complete generic person logo.

PAGE LAYOUT
Now, we will combine the logo, generic text and
a simple design for the page to create the layout
as finally displayed in Figure 17. To start this,
move your newly designed logo into the upper
left-hand corner of the document. Change its
color to be a nice purple/pinkish (hex: 3e3bd8).
Rather than rotating in large 90-degree incre-
ments, after selecting the logo, use the [ and ]
keys to rotate in default 15-degree increments
until the logo is offset as shown in Figure 17.
Select the logo and move it off the page so that
we can focus on the background image.

Creating the final background is quite simple
(Figure 10). In order to create these split planes,
we must use the Path menu commands once
more. Create one rectangle that is the same size
as the letterhead page. Then, duplicate this shape
and use the selection tool to shrink the size of the
duplicate upwards (see Figure 11, step 2). Select
both the original and duplicate. Go the menu and
select Path→Division. The result is similar to Figure

11, step 3, except the pieces are still together.
Now, set the outer piece of Figure 11 to a

lighter color. The inner piece then is slightly more
complicated in that it uses a gradient. To create
the gradient, first select the inner rectangle with
the selection tool, and then select the gradient
tool (Figure 12). Click the top part of the inner
rectangle, and while holding the Shift key down,
drag downward, attempting to achieve the look

that is shown in Figure 10. To change the colors
of the gradient, while the gradient tool and your
target shape are selected, click on the white box
at one of the end of the line representing the gra-
dient. This allows you to change the starting and
ending color of the gradient.

Next, we need to make a faded logo on the
bottom part of the image (see Figure 13). To do
this, duplicate the logo we created, pick it with
the selection tool, and drag (while holding the
Ctrl key) to scale the logo as shown in Figure 17.
Next, change the color of the shape with the Fill
and Stroke Dialog (Figure 14), primarily changing
the alpha so that other parts of the image show
through the faded logo.

Hiding the parts we don’t want to see requires
converting the object into a pattern. Select the
large faded logo and in the menu, select
Edit→Object to Pattern. This is usually used to cre-
ate a large repeating pattern, as we did in the
previous articles in the series. However, in this
instance, we are using it to create a mask, also
called a clipping path. Drag the bottom-most con-
trol point to the bottom-most right corner of the
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Figure 9. Rotating the Logo

Figure 10. Letterhead Background

Figure 11. Letterhead Background HOWTO

Figure 12. Gradient Tool
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letterhead page, thus hiding the rest of the faded
logo. Please note, this is really an unnecessary
step, as what is printed is only on the canvas, yet
it helps to visualize how the letterhead will look
once printed. Continue to tweak the faded logo
until it looks like Figure 13.

Now, reposition the logo on the page in the
upper left-hand portion of the letterhead, leaving
space to the right for text. To create text, select the
text tool (Figure 15) and drag it to about the height

of the logo and to where the inner rectangle ends
for the text area’s width. Type into this area the
information presented in Figure 17. Next, use the
text tool to select the title of the company,
“Generic People”. Open the Text and Font Dialog...
(Shift-Ctrl-T). Make the font size of this selection 32
points and Trebuchet. Select the other text and
make it 20 points. Also, change the color of this
text to something fun, like a nice purplish-pink.

Use what you just learned to create the Web
address at the bottom of the page, right where

the faded logo crosses the bottom transition
between the inner rectangle and the outer one.
Compare what you have created with Figure 17.

This completes the creation of a generic letter-
head for the generic company, Generic People.
This exercise uses many of the elements and prin-
ciples to construct a harmonious design between
simple geometrical elements like rectangles and
ellipses in order to create complex objects.

Notice how the eye moves from left to right in
this composition and a balancing of space feels
complete. The upper-left logo and text feel quite
heavy. In order to balance this out, we created the
faded logo and the Web address in the bottom
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Figure 13. Logo Faded
Figure 14. Fill and Stroke Dialog

Figure 15. Text Tool

Figure 16. Text and Font Dialog
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right of the screen to counter-balance the design.

OPEN CLIP ART LIBRARY
The Open Clip Art Library, http://www.openclipart.org,
is a massive clip art repository that consists of thou-
sands of clip art images submitted by normal users
like yourself. All of the work in the project is released
as public domain so that it can be used for any pur-
pose, both commercial and noncommercial.

Now that we have set up our letterhead prop-

erly, it is quite easy to submit this file to the
Open Clip Art Library (see Figure 18). First, make
sure your letterhead is saved as something like
letterhead.svg. Navigate with your Web browser
to http://www.openclipart.org. Find the box that
states: Read the Guidelines. Submit A File. Click
on the browse button in that box and select your
letterhead file. Then, click the Send File button.
Because we already filled out the Metadata fields
properly, our file automatically is saved to the
Open Clip Art Library. Congratulations! You have
contributed to an open-source project!

CONCLUSION
You have successfully learned the elements and
principles of design, made a complete composi-
tion and contributed to an open-source project. In
future months, look for expansions on these con-
cepts with other specific projects geared toward
becoming a better designer, user of Inkscape and
contributor to the Open Clip Art Library.�

Jon Phillips (http://www.rejon.org)
is an open-source developer, artist
and scholar with more than 12
years of experience building 
communities and working within 
computing culture. He is currently
developing Inkscape, the Open
Source Project, and the Open Clip

Art Library (http://www.openclipart.org). He teaches at San
Francisco Art Institute (http://www.sfai.edu) and now works for
Creative Commons (http://www.creativecommons.org).
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Figure 17. Final Letterhead

Figure 18. The Open Clip Art Library Web Page as
of 2005/08/01

RESOURCES

Inkscape: http://www.inkscape.org

Open Clip Art Library:
http://www.openclipart.org

“Graphic Design” (Wikipedia):
http://en.wikipedia.org/wiki/Graphic_design

“The Elements of Design” by Joshua David
McClurg-Genevese (Digital Web Magazine):
http://digital-web.com/articles/elements_of_design

“The Principles of Design” by Joshua David
McClurg-Genevese (Digital Web Magazine):
http://digital-web.com/articles/principles_of_design

“Composition” (Wikipedia):
http://en.wikipedia.org/wiki/
Composition_%28visual_arts%29

Gestalt (2D Design Notes): 
http://daphne.palomar.edu/design/gestalt.html

Society for Gestalt Theory and Its Applications:
http://gestalttheory.net

http://www.openclipart.org
http://www.openclipart.org
http://www.rejon.org
http://www.openclipart.org
http://www.sfai.edu
http://www.creativecommons.org
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http://digital-web.com/articles/elements_of_design
http://digital-web.com/articles/principles_of_design
http://daphne.palomar.edu/design/gestalt.html
http://gestalttheory.net
http://en.wikipedia.org/wiki/Composition_%28visual_arts%29
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It’s that time of year again—when tech fans of
all stripes look forward to the geeky gifts they’ll
find under the tree. Why should Windows users
get all of the tech treats, though? Here are a
few platform-agnostic technologies to appeal to
the Linux lover in your life.

MEMOREX 2GB TRAVELDRIVE

http://www.memorex.com
$180 US

One of best stocking stuffers out there
for anyone who uses a computer on a
regular basis is a USB Flash memory
drive. They’re compact, and they’re
plug-and-play on almost any recent
computer system. That, in fact, is one
of the best recommendations for the
USB Flash drive as a gift for Linux
users—they work well with most
recent versions of Linux, but they make
it easy to move files around between Windows,
Mac and Linux. Anyone who has to use multiple
operating systems during the course of the day will
find one useful.

Memorex’s TravelDrive series uses USB 2.0 for
speedy transfer of files, which means you won’t
have to sit around for minutes on end waiting for
files to copy over to the drive. The TravelDrive is
also available in capacities of up to two full giga-
bytes, which gives you plenty of space for data:

hundreds of songs or digital photos, thousands of
text documents or up to half an hour of digital
video. No matter how you slice it, that’s a lot of
data in your pocket.

Despite its high capacity, this little drive is just a
bit larger than a typical house key. As with many
other drives, this one is designed so that you can
put it onto a key ring if you want, and it even has
a reinforced aluminum loop on the end. It also
comes with a lanyard for those that prefer to sling
it around their necks.

PANASONIC LUMIX FZ-30

http://www.panasonic.com
$700 US

Consumer-friendly digital cameras are better than
ever, featuring higher resolution and a raft of
advanced features that puts semi-pro capabilities
into the hands of regular users. Now that most
cameras have adopted the PictBridge standard,
they tend to be seen by computers as removable
drives, allowing drag-and-drop downloading of
photos and videos, which is a definite boon to
Linux users—no more driver hacking in order to get
photos from a digital camera to a Linux machine!

Panasonic’s Lumix line may not be one of the
better-known brands, but it has been responsible
for bringing a number of technologies into the
mainstream of digital photography. The new eight
megapixel FZ-30 definitely makes good use of

those technologies.
One of those technologies is optical image sta-

bilization, known on the Lumix line as Mega O.I.S.
Optical image stabilization features a lens that
automatically adjusts to compensate for erratic
and unwanted hand motion, redirecting incoming
images to the proper place on the imaging sensor
to avoid streaked and blurred images. The tech-
nology was originally brought in from Panasonic’s
digital video camera lineup, used to cut down on
that swaying picture that tends to make people
seasick while watching; on a digital still camera, it
helps with longer-exposure shots, which means
better pictures in lower light.

Previous models in Panasonic’s Lumix FZ lineup
have featured ultra-zoom capabilities—12x optical
magnification, in fact—but the Lumix FZ-30 does
those previous models better in two key ways. First
of all, the zoom is controlled by a mechanical ring
around the lens, which means the zoom kicks in as
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fast as you can crank the lens—no more waiting
around for the zoom motor to get to where you
want it to be. Secondly, because of the way the
lens is designed, that 12x optical zoom actually
increases to 15x optical zoom when the camera is
dropped into five megapixel resolution, and to
19.1x optical zoom when the camera is in three
megapixel resolution. You can extend these zoom
ranges even further, but typically that degrades
quality, and consequently, it’s not recommended. (In
most cases, 12x optical zoom is plenty, anyhow!)

Another nice feature on the lens is the ability to
focus manually. This isn’t new to this model, but with
the focus ring tucked neatly behind the zoom ring, it
puts both of these controls within easy reach. The
switch for manual and auto-focus mode sits a bit fur-
ther back on the lens, and it also features an option
for macro auto-focus, for those times you need to
get right close up. I’m still impressed by the manual
focus capabilities on the FZ series. When you’re in
manual mode and you move the focus ring, a magni-
fied window appears in the centre of the LCD
viewfinder (either the articulated one on the back of
the camera or the smaller one in the eyepiece) to
allow you to focus better. Despite the relative graini-
ness of these LCD viewfinders when compared to an
optical eyepiece, you can still focus properly.

The biggest disappointment here is the same
thing that continues to disappoint with most digital
cameras: the small memory card. The Lumix FZ-30
comes with a 32MB SecureDigital card. Although
it’s nice that there’s a card included at all (in an era
when many manufacturers are starting to skip
including a card altogether), the 32MB card will
hold only about ten shots in high-quality mode,
and it will hold only one shot in either TIFF or RAW
mode—not much storage at all, really. In other
words, you may want to consider picking up a

high-capacity SD memory card when you pick up
the FZ-30. Considering the kind of quality you can
get out of the camera, whoever’s using it almost
certainly will want to take more than ten pictures
before having to offload them to the computer.

ROBOSAPIEN V2

http://www.robosapien.com
$249 US

It doesn’t matter what kind of
computer system you call
home—everybody loves robots!
The first version of the
Robosapien was one of last year’s hottest gifts, and
this year Robo is back, and bigger than ever!

Robosapien v2 is larger than the last model—he
stands 24 inches tall, in fact—but despite the added
heft, this new version is more nimble than ever, with
a more-natural gait and a lot more joints that result in
added mobility. In fact, although the first Robosapien
tended to walk across the room like a lurching behe-
moth, Robo v2 can walk not only more naturally, but
he also can sit down, get back up again, lay down
completely, perform martial arts more accurately and
other such tasks. And instead of the three pincher-
style fingers found on the last version, Robo v2 actu-
ally has a thumb and four jointed fingers, allowing it
to pick up and hold things in a more natural manner.
All movement is accomplished using a new gaming
console-style controller with thumb sticks that allow
more natural, fluid movement.

The little guy also has more sense than before.
Robo v2 can “hear” in stereo, allowing him to
localize sounds and react to them. He also can
“see” different colors, including the ability to rec-
ognize skin tones. He even can follow a laser trail

provided by the controller unit. (For the record,
the controller uses three AAA cells; Robo himself
is greedier, requiring six D cells.)

If that wasn’t enough, Robo is now more of a
family man—well, kinda. In addition to the new
Robosapien v2, WowWee released two other
robotic toys earlier in the year, and Robo v2 actual-
ly has the ability to control them as if they were his
pets. The first is a small dog-like robot known as
the Robopet ($100 US); this little guy skitters
around your house autonomously, rolls over, pre-
tends to pee on your floor, and “good pet” and
“bad pet” commands from its remote control
allow you to mold its behaviour. Even weirder is
the Roboraptor ($120 US), a dinosaur that stands
upright on two feet, bites your finger and reacts in
a very primitive way (naturally) to its environment.

On a more serious note, it may be worth not-
ing that with the growing intelligence built in to
even these “toy” robots, it’s only a matter of time
before robots rise up and try to take control of
the world. This may be a good time to invest in
Daniel H. Wilson’s new book How to Survive a
Robot Uprising: Tips on Defending Yourself
Against the Coming Rebellion, available now in a
book store near you—before it’s too late.�

Sean Carruthers is a freelance technology
journalist from Toronto. He spent six years
at Canada Computer Paper, first as
Products Editor at The Computer and later
at HUB Digital Living magazine. As a free-
lancer, he has written for the Globe and
Mail, http://globetechnology.com, HUB

Digital Living, Computer Dealer News, Homefront and CE-Biz.
Although a relative newbie with Linux (SUSE, thank you very
much), he has extensive experience with tech gadgets of all sorts
and is enjoying figuring out which ones are compatible with Linux.
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